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Installation Guide for ZAP MON 6808

This chapter describes how to install the COSMIC ZAP C Cross
Debugger the MC68HCO8 on-chip monitor on your host system.
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Preparing For Installation

Your ZAP package consists of the ZAP Debugger, installation script
files, tutorial files, and help files. To use ZAP, the following is
required:

* A PC with an Intel Pentium or compatible microprocessor.

e Microsoft Windows 95/98/ME, Windows NT 4.0 or
Windows 2000 operating system.

*+  CD-ROM Drive
* Hard disk drive with at least 20 Mbytes of free space.
*  Minimum of 16 Mbytes of Extended RAM

Each software CD in the package has a printed label identifying the
product, the product version number and the license serial number. In
the installation instructions that follow, we assume that your CD-
ROM drive is designated by D: and your hard disk partition by C:. If
your system uses different device names for your disks, you should
adjust the installation instructions accordingly.

Installation Process

Z AP is installed by an Installshield setup program. Throughout the
installation procedure, there is an assumed default directory in which
Z AP will be installed. This directory is c:\cosmic\zapmon08. If you
install ZAP in a different directory or on a different hard disk drive,
you must substitute your specified location wherever you see
C:\cosmic\zapmonO08.
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Running the Installation Program
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1.

Insert the Cosmic Product CD into your CD-ROM drive.
A Demoshield window should automatically appear. If it
does not appear double click on cosmic.exe in the CD’s
root folder using a Windows file explorer.

wingtall Products

OSMIC

Software

—

2. Click on “Product Documentation” to view any of the

Product user’s manuals. Click on the “main” button to go
back to the main menu for product installation.

Note: The documentation is provided in Adobe PDF
format. If you don’t have the Acrobat reader goto the main
installation screen and click on “Install Products” then
“Utilities” and then “Acrobat Reader” to install the Adobe
Acrobat Reader.
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Click on “Install Products” and then click on the product(s)
you wish to install.

a) Install the compiler before installing IDEA or the
Codewright Integrator so the examples provided will
be configured properly.

b) Complete one installation before starting another.

An Installshield window should appear. The installation program,
allows you to select the hard disk drive and directory where ZAP will
be installed. Follow the on-screen instructions to complete the instal-
lation. If you do not specify your own installation directory, ZAP and
its associated programs will be installed in the folder
C:\cosmic\zapmonO8 directory.

4.
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If you received a hardware key (dongle) with your distri-
bution attach it to your PC at this time and follow the
instructions below to install the dongle drivers.

a) Click on the Utilities Button from the Install products
page.

b) Click on Dongle device drivers and follow the on-
screen instructions to install the necessary dongle
device drivers. The drivers are necessary in order to
use the dongle in conjunction with another parallel port
device.

If you purchased a node locked license without a dongle
then install all of the software as described above and then
click on “Register Cosmic Software”. Fill out the regis-
tration information and click on send. This will send an
email with the appropriate information to the Cosmic
licensing department and they will return a text file license
key via email.

a) Copy the license text file into the license subfolder
under each of the products installed.
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If you purchased a floating license Click on the Utilities Button from
the Install products page. Click on view “Float License Readme™ and
follow the instructions to install the license manager and clients.

Starting and Configuring ZAP MONO08

ZAP MONOS8 communicates to the target via a standard serial
connection using a COM port on the PC to connect to the 68HCOS
monitor circuit or compatible cabeling device. This requires a
“Monitor Mode Circuit” or equivalent as defined by the Motorola
specification in order to interface to the 68HCO08’s monitor mode.
See the Technical Data Book for the 68HCOS8 family member for an
example “monitor mode circuit” and connection details. Please read
and perform any hardware setup and configuration for the target
hardware such that a serial connection can be made to the Monitor on
the target. Be sure to supply the target with the appropriate power
including any Flash programming voltages that my be required.
Connect a serial cable to an available serial port on your PC and
connect it to the target via the Motorola standard MONOS8 serial
connection.

On startup, ZAP will try to communicate to the target via MONOS
using the previously saved configuration if any. The configuration is
stored in the initialization file ZAPMONO8.ini located in the
Windows folder. If communication cannot be established or security
does not pass using the previous configuration then the Setup window
will appear. You may also select Connect from the Target menu at
any time to view or change the current configuration or security and
reconnect to the target. Note: The Monitor interface requires a power
on reset before reconnecting after a failed connection or security
failure.
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The Setup window provides the following configuration options:

Part: Target: |GP32 j
Baud Rates
" UsgerDefined (* Standard
Connect
9500 =]
™ Load Yerify

Security

@+ UserDefined ™ Getfrom S-RECORD " Getfrom file

All Dxff All D00

e O O Y N O O R

Exechode

" HARD Breaks mode (far FLASH) # SOFT Breaks Mode

Connection

RESET BOARD BEFORE CLICKING CONNECT !

ZAP MONO08 Standard Connect and Setup Window

PORT - Select the PC Comport which is connected to the Monitor
circuit.

Target - Select the appropriate 68HCOS target processor. This setting
is used for Flash programming. If the target you’re using is not listed
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then ZAP will likely connect, but will not be able to program any
Flash that might be available.

Baud Rate - click on Standard and select an available Baud rate from
the pull down menu if you are using a standard crystal frequency and
not using the PLL. If you are using the PLL select “User Defined”
under baud rates and enter the additional information where:
Connect - is the baud rate available for the initial connection
which is based on the crystal speed alone.
Command File - is a ZAP command file that modifies the PLL
and creates a different baud rate that you want to use. This file
is executed every time you reset the processor or reconnect to
the target.
Bump To - is the new baud rate created by the PLL change.
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Note: The baud rate used is dependent on your hardware crystal speed
and PLL setting and not all standard baud rates are attainable.

Port: [comt =] Target |aPaz =]
—Baud Fates
& User Defined  Standard
Connect Comrnand File Burng to
4800 PLL_9600.cfy Browse | IQEDD
I~ Load Yerify
— Security
@& User Defined © Getfrom S-RECORD © Getfram file
Al Dxf | All 0x00 |
Security IDxD IDxD IDxD IDxD IDxD IDxD IDxD IDxD
—Exechiode
 HARD Breaks mode (for FLASH) & SOFT Breaks hode
—Connection
RESET BOARD BEFORE CLICKING COMNECT |

ZAP MONO08 Connect and Setup with PLL Window

Load Verify - Select this box to have ZAP verify every image that is
downloaded through the File menu.
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Security - The 68HC08 Monitor provides some security against
reading the internal Flash. In order to connect and pass security and
subsequently read and debug a flashed application ZAP must send the
last 8 bytes of the existing Flash which is in the vector space. There
are a couple of ways to set the security bytes as described below.
However, if these values are not known then security will fail and
Z AP will be unable to enter the monitor mode and the only alternative
is to erase the Flash, power on reset and submit all 0xFFs (erased
values) for the security bytes.
User Defined - Select this option and enter the security bytes
by hand or click on all 0xFF or all 0x0 to set the security bytes
that ZAP will use.
Get from an Srecord - Select this option and an Srecord which
contains the security bytes as part of the image. ZAP will
extract and send the security bytes from the Srecord if
available.
Get from File - Select this option and a Cosmic Executable
.h08 file which contains the security bytes as part of the image.
Z AP will extract and send the security bytes from the
executable file if available.
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Execution Modes

The execution mode selection is used to control how ZAP sets break-
points and executes the user’s program. There are 2 different modes
which provide various capabilities depending on your target
hardware. Select one of the following modes as the default for the
debugging session.

Software Breaks Mode

This mode provides the most real-time debugging flexibility,
but requires the code to be executed in RAM.

Breakpoint Mechanism - In this mode, ZAP swaps the
instruction at the desired breakpoint address with an SWI
instruction. You can set an unlimited number of breakpoints in
this mode and Execution using the “go” command or button
will run in real-time. This mode requires that the code is
downloaded and executed out of RAM. i.e. R/W memory.
Each time ZAP stops the instructions are swapped back into
memory for accurate single stepping.

NOTE: This mode cannot be used when debugging code
programmed into FLASH.

Use Hard Bkpts

This mode is used to debug code programmed into the internal
FLASH of various HC08 family members which also include
hardware breakpoint modules.

Breakpoint Mechanism - In this mode, ZAP uses the on-chip
hardware breakpoint module to set breakpoints. The current
hardware implementations will support 1 instruction break-
point. ZAP is therefore restricted to 1 breakpoint at a time in
this mode. ZAP will issue an error if more than one breakpoint
is set and you attempt to execute (GO) the code.

If you receive an error “too many breakpoints” then you must
delete breakpoints until there are no more than one before you
can execute again.
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Stepping Mechanism

In Soft Breaks Mode, ZAP will single step by setting multiple SWI
instructions in order to provide assembly and C source stepping.

In Hard Breaks Mode, there is only one breakpoint available to use

for single stepping so in most cases C source level stepping is not

available however, assembly instruction stepping is still available.
Instruction Step - When the user selects “Step Instruction”

from the Debug menu or clicks on the single foot E , ZAP
issues one instruction step to the target

Source Step - When the user selects “Step” from the Debug
menu or clicks on the double foot - ZAP issues sequential
instruction steps until the next active source line is reached.

Stopping Execution
The 68HCO08 on-chip monitor provides an execution command,
but unfortunately does not provide a stop command and
therefore there is no easy way to stop processor execution once
started unless the hardware breakpoint is set and reached. The
default behavior of ZAP is to disable the Stop command.
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Programming On-chip Flash

ZAP can be used to program the on-chip flash for supported 68HCOS
devices. ZAP provides two ways to program the Flash. You can use
the standard Load from the File menu to load Cosmic Executables
(.h08 extension) or use the Flash programming Window to program
any S-record.

Using the File Menu to Program Flash
To program the on-chip flash using Load from the File menu,
select “Load Options->Code and Symbols” from the setup
menu so ZAP will load the code image as well as the debug
information. Choose Load from the File menu and select a
COSMIC executable file (.h08) that contains an image linked
to the flash address space. ZAP will automatically erase,
program and verify the flash with the code and const image
contained in the exec file (.h08). This will also load and setup
all of the debug information contained in the image.

NOTE

When loading through the File menu, ZAP will erase the entire
Flash including the boot block and security bytes.

Programming an Srecord
ZAP also provides a mechanism to program any Srecord into
the Flash. Select “Target->Flash->Program/Erase Flash” to
open the Flash Programming dialog box. This window allows
you erase and/or program the flash by block. This will
program only the image. It does not setup the debug infor-
mation. This must be done separately through the file menu.
See the section “Debugging an Srecord in Flash”.

File
Enter or Select an Srecord to program. Then Click on Program
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button to program the flash. The Window will disappear if the
programming is successful.

Capture

This section is used to select an address range of an Srecord to
program the flash. The default is to program the entire
Srecord.

All - Select this option to program the entire Srecord.

Select - Choose this option to enter an address range to
program. This option allows you to select an Srecord that
contains more records than you want to program. ZAP will
only program records within the specified range.

Erase Block - Select which Flash blocks are to be erased.
Selected blocks will be erased and verified immediately when
you click on the Erase button. Selected blocks will also be
erased and verified before an Srecord is programmed.
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ACR s nmia -

il Frogram the Flash X
File:

Il Browze |

— Capture

™ Select oAl

r—Eraze Block

¥ Erase FLASH [0=8000...)

Program I Eraze | LCancel |

ZAP 6808 MONOS Flash Programming Window

Debugging an Srecord in Flash
If you choose to program an Srecord into the Flash or if the
image is already programmed into flash then you MUST also
Load the debug symbols that match the Srecord in order to
perform source and/or symbolic debugging. This is a two step
process.
First program the Srecord using the “Flash Programming”
window or some other flash programmer. Second, load ONLY
the debug symbols that match the Srecord. The debug symbols
are contained in the Cosmic executable file (.h08) along with a
copy of the Srecord image. Since the code is already
programmed, you need to select the “Load Option->Symbols
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Only” from the Setup Menu before loading the .h08 file. Then
Choose File->Load and select the .h08 file that was used to
create the Srecord. You should now be ready to use the high
level debugger.

NOTE

The Flash Programming Window may be different than the one
shown above depending on the Target selected. However, the
options and functionality are the same.

Target Menu

The Target menu in ZAP 6808 MON provides options and features
specific to the 6808 Monitor environment. The following options are
available.

Reset - Reset is only available with the ICS kit or an equivalent
circuit. The standard one pin interface does not support a reset.

Baud Rate - This option allows you to change the baud rate of the
communications between ZAP and the Monitor. ZAP will attempt to
bump up to the selected speed and reconnect to the Monitor. Ifit is
unable to connect at the higher speed it will try lower speeds until it is
able to reconnect.

Program/Erase Flash - Opens the Flash Programming dialogue box
described above. This dialogue box allows you to program or erase
the flash explicitly . See the section “Debugging Out of FLASH” for
details.
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Verifying Installation

Make sure the is properly configured. Select ZAP 6808 MON from
the Start Menu to open the ZAP debugger . The main ZAP window
should now be active.
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Choose Load from the file menu.

Select the file c:\cosmic\zapmon08\examples\demo08.h08
by clicking on it and then clicking on OK. Note: The
demo examples may need to be relinked for use with some
target systems or processors. Compare demo08.map with
the processor map and target system memory map if
download fails. ZAP should load the file and you should
see either the source (if compiled in debug) or the disas-
sembly of the startup routine.

Choose Step from the Debug menu
The source file CRTSI.S should appear in the source
window and the first line should be highlighted.

Choose Registers from the Show menu to open the register
window.

Choose Stepinst from the debug menu or click on the

single foot in the button bar E to step one assembly
instruction at a time. Instruction step a couple of times and
you should see the program counter (PC) in the register
window incrementing. The blue highlight which denotes
the current assembly instruction should also move down
one instruction at a time in the source and disassembly
windows.

Choose Go to Function Entry from the debug menu, select
main and click OK. The source window and the PC
should move to the first line of the main function.

Click on the Source Step button in the button bar a
couple of times and you should see the blue highlight for
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the current line of C code trace through execution one C
line at a time.

8. Double Click on the variable “count” or “swi_count” and
select monitor from the pop-up menu.

9. Click on the green light or select “go” from the debug
menu and wait a couple of seconds then click on “stop”

10. Check the values of “count” and “swi_count” in the
monitor window. The values should increase during
execution.

If you observe the behavior described with each action above then
ZAP should be configured correctly.
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Compiling Programs for Cross Debugging

The COSMIC ZAP debugger requires your application to be built
with the COSMIC C cross compiler or its equivalent, version 4.0 or
higher. To compile your C programs for full C source level cross
debugging with Z4P, you must specify the +debug compiler option
when you compile your program. The command line will have the
form: where <options> are any other compiler options you wish to

cx6808 -v +debug <options> <filel.c> <file2.c>
<file3.c>

specify, <filel.c>, <file2.c> and <file3.c> are the C source
files that will make up part of the linked executable.

When you specify +debug, the compiler includes all of the necessary
cross debugging information required by ZAP. The debug infor-
mation is kept in a separate, hidden section on the host system. You
should not attempt to link the debug section explicitly.

To build an assembly file for assembly source level debug you must
use the -x assembly option. The following is an example command
line for the assembler:

ca6808 -vl -x <file.s>
OR
cx6808 -vl -ax <file.s>
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CHAPTER

1

Overview

The COSMIC ZAP source level cross debugger is a full featured MS-
Windows cross debugging environment. It is designed to provide a
powerful yet intuitive Windows interface for efficient cross

debugging of embedded applications. 4.0xThis chapter provides an
overview of ZAP’s main features and a description of the various
target configurations available. The following sections are included:

+ ZAP Display Windows
¢+ ZAP Debugging Features
¢+ ZAP Target Configurations

Page 1-1



Overview

ZAP Display Windows

ZAP is a true MS-Windows application providing an infinite combi-
nation of display options. You can open and arrange any combination
of the following windows. You can even change each window’s font
and highlight colors.

Source Window

The Source window displays the C or Assembly source code
for the active function and maintains the active instruction
highlight for the current line of source code.

Disassembly Window

The optional Disassembly window displays a disassembly of
the current page of code. The disassembly display is coordi-
nated with the C or Assembly source window to provide simul-
taneous debugging of C and assembly. With ZAP, you can
even set breakpoints in the Disassembly window.

Command Window
The optional Command window gives you the option to use
ZAP's robust command language.

Monitors Window

The Monitors window is an optional relocatable window that
displays monitored (or watch) expressions and variables. This
window allows you to point and click on monitored objects to
change their format or update their value.

Register Window
The Register window displays the current values of the CPU
registers and displays changes between commands in color.

Stack Window
The Stack window displays the current stack frame including
function arguments.

Data Windows
You can open multiple Data windows to display a memory
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dump or disassembly anywhere in your memory map.

Variable Window
The Variable window displays the address and value of all
variables in the current scope in one of several display formats.

Toolbar
The Toolbar is a relocatable push button window providing

easy access to some of the most commonly used debugging
commands.
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ZAP Debugging Features

ZAP provides many features tailored specifically for the embedded
systems developeiTheuser interface is almost entirely processor
and execution configuration independent. If you are debugging code
on several processors or different target configurations your
debugging skills are entirely portable. The following sections briefly
describe the high level user interface common to all target configura-
tions of ZAP.

Non-intrusive Debugging

ZAP does not modify your code in any way. The symbol information
ZAP uses is produced in separate, transparent sections, which resides
on the host. The code you cross debug is that which you intend to
execute in your final product, not an intermediate language. You can
PROM your code or download it to the target environment directly
after debugging with ZAP (No recompiling or relinking is required).

Source Browsing

Zap's unigue source browser allows you to search and view all of
your source code in multiple discrete windows. You can set and edit
breakpoints anywhere in your code without changing the source
window or the current state of execution. ZAP’s powerful browser
feature also lets you quickly search and monitor variables and break-
points.

Graphical Performance Analysis

ZAP’s performance analysis feature gives you a graphical represen-
tation of code coverage and MCU cycles. Code coverage can be
displayed on a file by file, function by function basis. This feature
gives you a relative comparison of your codes efficiency, thus
allowing you to go back and optimize the code to get the most out of
your embedded project. (Available only in simulation version)
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C and Assembly Trace

The C and Assembly Trace feature allows you to record and playback
any sequence of C or Assembly instructions. You can move
backwards and forwards through the recorded trace one instruction at
a time or in a continuous playback mode. To help you save time, you
can even exclude functions you want to trace over. (Not available in
all configurations see the Chapter titled “Advanced Topics” for
details)

Time Line Chronograms

The Chronology feature provides a chronogram or graphical time-line
of function calls. A proportional bar chart is used to denote entry and
exit from a function with relation to the total number of cycles
executed. You can display the chronology of function calls. ZAP can
even report chronology on interrupt service routines so you can keep
track of external events as well as internal function calls. (Not
available in all configurations see the Chapter titled “Advanced
Topics” for details)

Chromacoding

ZAP provides syntax color coding of C key words, C library
functions to make it easier to follow the flow of your program.

Breakpoints

ZAP's powerful breakpoint facility lets you set an unlimited number
of breakpoints in any source window with a simple double click of
the mouse. You can attach debugger actions, user commands, and
complex expressions to any breakpoint. You can even set complex
breakpoints.

Expression Evaluation

ZAP allows you to evaluate and monitor variables and expressions by
double clicking on them or selecting them with the mouse.

Page 1-5



Overview

Single Stepping C and Assembly

ZAPs stepping facility lets you to step through your program at the C
and assembly level, step into and over function calls and perform
conditional stepping.

Automated Debugging Sessions

You can us&APs file redirection and log file management facilities
to automate debugging sessions. You can record and play back all or
part of a debugging session.

On-line Help Facility
ZAP provides an extensive Windows on-line help facility. Double
click on a C keyword, library function in the source window to open a

syntax help window. Choog@n C Libraryfrom the help menu to
display a list of ANSI C functions and hypertext manual pages.

Comprehensive Debugger Command Set

In addition to the many mouse and menu features, ZAP provides an
extensive command language for those who prefer command entry to
mouse operationsZAP’s comprehensive set of commands allows

you to cross debug your code at both the C source and Assembly
language levels.
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ZAP Configurations

ZAP is available in four target configurations to provide debugging
support for all phases of development. All of #%P debuggers
share the same high level Windows interface and command set so
there is no additional learning curve as you progress through your
development or change to another supported environment. The
available configurations include:

Simulator Configuration

This version oZAP integrates a CPU simulator with a full C and
Assembly source level debugger to provide a debugging environment
which doesn’t require any external hardware. This version is useful
during the early stages of development when you're trying to debug
your algorithms or when hardware is simply not available.

Monitor Configuration

This version oZAPis designed to work with several standard
prototype or evaluation board€AP uses a small monitor program
which is downloaded to the board to create its debugging
environment. This provides a low cost hardware debugging solution.

Background Debug Mode Configuration

In recent years, some chips have been equipped with Background
Mode debugging support. The Background Debug Mode (BDM) is
essentially an operating mode and instruction set which allows access
to the chips internal operations and target resources without the need
for a monitor. This version of ZAP is interfaced through the parallel
port of a PC or workstation to the standard BDM port using the
standard Motorola (P&E) cable. You can debug directly on your
target board or use a standard evaluation board. This configuration
provides a real-time debugging solution with a minimum of setup
time and hardware expense.
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In-Circuit Emulator Configuration

ZAP has also been interfaced with several full featured in-circuit
emulators to provide the optimal debugging environment. This
version ofZAPis often used in the latter stages of development to
fine tune optimizations and track down the hard to find bugs in
complex embedded applications.
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CHAPTER

2

Using ZAP

This chapter describes the basic invocation and operation of the
COSMIC ZAP debugger. This chapter assumes that you have read
the Installation Guide and have properly installed the debugger and
setup the execution environment. This chapter includes the following
sections:

¢ Starting ZAP

¢ ZAP Window Displays

+ Screen Display Options

¢ Loading an Application (File Menu)
+ Utilities Menu

¢ On-line Help facility
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Starting ZAP

The easiest way to start ZAP is to locate the ZAP icon and double
click on it. Alternatively, you can select ZAP from the start menu
under Windows 95/NT. This will bring up the main debugger screen
as shown below. This screen consists of the ZAP desktop, menu bar
button bar and status bar.

P e

B0 Tmi i il
|

J?‘: e ¢
0= Source Window

AT me i - Hy b
Cell=lll = @

Status Bar

Figure 2-1 ZAP Main Window

Page 2-2



Using ZAP

ZAP Windows

In addition to the main debugger screen, ZAP uses several optional
windows to efficiently display and control the debugging process.
Each window can be opened, closed, moved and resized using
standard Windows 95/NT mouse commands. The optional windows
are available under tHfghowmenu. Simply select the desired

window to open it and select it again to close it.

Source Window

The Source window is the leftmost window in the main display and
accepts point and click breakpoints and expression evaluation. The
Source window displays the C or Assembly Source code for the
active file and function and maintains the active instruction highlight
for the current line of source code. Source code is shown with bold
line numbers when assembly code is actually produced for the source
line and gray line numbers for source lines that didn’t produce any
code (i.e. #defines, #iifdefs etc.). The Source window also provides
color coded syntax and on-line help for C keywords and C library
functions. Simply double click on any C keyword, library function

to pop-up a syntax help window. You can enable/disable syntax color
coding by selectin@yntax Coloringrom theShow menu.

Button Bar

The Button Bar consists of graphical push buttons which duplicates
many of ZAP’s most heavily used commands. The button Bar can be
turned on and off by selecting Button Bar from the view memory.

Toolbar

The Toolbar provides a fast convenient way to access the more
frequently used debug commands. The Toolbar option under the
Showmenu controls the orientation of the toolbar dialog box.
Choose ToolbasHorizontal or Vertical to open the toolbar with the
desired orientation. The Toolbar is completely relocatable so you can
place it anywhere on the screen.

Page 2-3



Using ZAP

Command Window

The Command window is an optional relocatable window used to
enter and display debugger commands and output. See the Chapter
titled “ZAP Commands” for details.

Disassembly Window

The optional Disassembly window displays a disassembly of the
current (or active) page of code. This display also maintains a
highlight on the current assembly instruction and a secondary
highlight on the assembly instructions that correspond to the active
line of C code or assembly macro. This Disassembly window also
accepts point and click breakpoints on instruction addresses.

Memory Window

The memory window is an optional relocatable window that displays
a block of memory in one of several formats including disassembly
(code), hexadecimal, octal, binary and decimal. You can have the
ASCII representation of the memory block displayed alongside the
memory dump to help you find and monitor strings at the low level.
Memory changes between commands are highlighted so you can
easily track memory modifications as your program executes. You
can modify memory by clicking on the desired data value and typing
a new value. You can also choose to disassemble memory by
selecting Code in the Memory Configuration window. You can set
breakpoints in the disassembly by double clicking on the assembly
address.

Monitors Window

The Monitors window is an optional relocatable window that displays
monitored (or watch) expressions and variables. This window allows
you to point and click on monitored objects to change their format or
update their value.
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Register Window

The Register window is an optional relocatable window that displays
the current values of the CPU registers and displays changes between
commands in color. This display allows you to click on any register
name to change its value to an application symbol or double click on
it's value directly to change it explicitly from the keyboard.

Stack Window

The Stack window is an optional relocatable window that displays the
current stack frame including function arguments. You can double
click on a function name in the stack frame to open up a source
browser window.

Status Bar

The optional status window is a small grey bar located below the
source window This window displays the current status of the
system. (i.e. running, stepping etc.)

Variable Window

The Variable window is an optional relocatable window that displays
the address and value of all variables in the current scope in one of
several display formats.
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Screen Display Options

ZAP allows you to customize the screen layout, text fonts and colored
highlights of the various screen displays. All of these attributes can be
changed using th8etup and WindowsMenu. To save changes to
window layout fonts and color highlights chod&ave Config On Exit
from theSetup menu.

Windows Menu

ZAP uses the standard Window 95/NT display options Free, Cascade,
Horizontal Tile and vertical Tile. These options are found under the
Windows menu. The Windows menu also maintains a history list of
all open windows including those minimized. Choose an open
window from the history list under th&indows menu to bring it to

the foreground and make it active.

Free Allows you to place and size all windows by hand
with new windows opening with the default size
and on top of other windows.

Cascade Displays all windows cascaded from top left to
bottom right with new windows cascaded on top
as the last window.

Horizontal Tile - Displays all windows in a wider horizontal size.
Each window is proportionally sized to fill the
entire main the window without overlapping.

New windows are added from the top left corner
and push the other windows down and then up to
the next column to keep the display proportional.

Vertical Tile - Displays all windows in a taller vertical size.
Each window is proportionally sized to fill the
entire main window without overlapping. New
windows are added from the top left corner and
push the other windows to the right and then
down to the next row to keep the display propor-
tional.
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Setup Menu

Load Option (Code and Symbols)

This option allows you to choose whether to load the code
portion of the image. In some case, typically when a hardware
version is used, you may load the code portion via another
method such as a serial programmer. In this case, you can
choose to load only the symbols through ZAP and debug the
matching code which is already available in the target system.
The default is to load both the code and symbols.

NOTE

In all cases symbols are not loaded to the target system. Al
symbols are loaded and kept on the host. If you plan to loadl
only the symbols it is required that the code image and the
symbol image are created from the same executable (i.e. linker
output). If they do not match the behavior is undefined.

Colors

Each color option item listed under the options menu opens a
Windows color pallet for selecting the desired color. Simply
click on the desired color and click OK to change the color.

Events

Changes the highlight color for active and suspended
events. This highlight appears on the C line number in
the source window when a breakpoint is active or
suspended. The highlight also appears in source and
event browser windows.

Disassembly

Changes the color of the disassembly highlight in the
disassembly window. This highlights the assembly
instructions that correspond to the current line of C code.

Instruction
Changes the color of the highlight for the current
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assembly instruction or program counter in the disas-
sembly window.

Memory
Changes the color of modified data in the Memory
window.

Source
Changes the color of the highlight for the current line of
C code in the source window.

Search
Changes the color of the highlight for lines found in a
search. the current line of C code in the source window.

Syntax Coloring

ZAP provides syntax color coding of C key words, C
library functions and kernel objects to make it easier to
follow the flow of your program. If you prefer you can
change the color used for a particular object or disable
color coding altogether. To enable/disable all syntax
coloring choose syntax coloring from the view menu.
To change a particular syntax color choose the syntax
type that you want to change from the Syntax coloring
submenu.

C Comments
C Key words
Library Functions

Mnemonics - (Assembler mnemonics)

Fonts

The font option allows you to change all of the fonts to your
own taste or selectively change the fonts for the different
windows. Each selection will open up a Windows font dialog
box which allows you to choose any available font.

All Changes the default font for all the windows.
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Browser Changes fonts for all the browser windows.
Commands Changes Command window fonts.

Memory Changes the fonts for the data or memory
dump window.

DisassemblyChanges the font for the disassembly
window.

Monitors ~ Changes the font for the Monitor window.
Registers Changes the Command window fonts.

Source Changes the font for the C source code
window.

Stack Changes the font for the Stack display
window.

Key Binding (Keyboard Short-cuts)

ZAP's key binding facility allows you to attach or bind short-
cut keys ZAP commands and tasks. Simply select click on the
function key by itself or in combination with the <Shift> and
<Control> keys and then choose a ZAP function from the
binding pull down list and then click OK or on another function
key to save. Key bindings are saved in the ZAP initialization
file (.ini) when the configuration is saved. This mechanism is
in addition to the standard Windows shortcuts denoted by the
underscored letter in each command.
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Key Binding l

Key Selection |

F1|F2|F3|F4| F5|FE|F?|F8| FS|F'ID|F‘I'I|F'I2|

Shift | Chil |
Key: |<F5> Clear |

Binding:

Ok LCancel |

Figure 2-2 Key Binding Setup Box

Path Editor

The path option is used to define the search path to the source
files. By default, ZAP searches the directory where the
debugger is installed. Using the PATH editor you can browse
through the directory structure to add the appropriate search
paths. Simply double click on the desired path and click on
Append, Add before or Add after to place the current path in
the desired place in the search path. ZAP searches from top to
bottom in the Path Editor to find source files.
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Figure 2-3 Path Editor

Default Int Format

This option specifies the default display format for the variable
browser window. Choose binary, decimal, octal or
hexadecimal.

Save Config

This option saves ZAP’s configuration immediately. The
configuration save includes the location and size of the
following windows if they’re open when performing the save.
The Main ZAP window, Disassembly, Monitors, Regsters,
Stack, Status and Toolbar. ZAP also saves the fonts, highlights
and colors.

Save Configuration on Exit

This menu item is used to turn tBave Config on Exiption

on and off. When the menu item is on (checked) ZAP will
save the location and size of the following windows if they're
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open when exiting ZAP. The Main ZAP window, Disassembly,
Monitors, Regsters, Stack, Status and Toolbar
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Loading an Application
File Menu

Load

The Loadoption opens up the load dialog window as shown below.
You can browse and select the load file by choosing a folder from the
“Look In” pull down menu. The debugger accepts an absolute object
file from the appropriate COSMIC compiler (i.e. output file from the
linker). This file should be built with the +debug compiler option to
include C source level debug information. For Assembly source level
debugging, use the -x assembler option. Once the file has finished
loading, the program counter is set to the address of the symbol
__stext or the beginning of the first segment in the link file if the
symbol __ stext is not defined. This is typically the address of the
beginning of the assembly level startup routine (crts.s or crtsi.s),
which is used as the default reset vector.

Load HE |

Loak i I £ bus_state_analyzer_test

File namne: Ibsa_DB_azBZhEIE! Open I
Files of type:  [HOB Files(* h08] =] Cancel |

Figure 2-4 Load Menu
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Application Map

Choose application map to display the application segments along
with their corresponding starting and ending addresses and segment
sizes.

Load and Save Layout

ZAP Allows you to save and restore the screen layout at any time.
The save layout command saves the size and location of the following
windows: Source, Disassembly, Registers, Stack, Command,
Monitor and the main ZAP desktop window.

Load and Save Session

The save session command is a superset of the save layout command.
In addition to the layout, the save session command saves the last file
loaded, the contents of the monitor window and any data windows
and their addresses. The load session command opens all of the
windows in the layout and then loads the saved application. Once the
application is loaded ZAP will then fill the monitor window with the
saved variables and open any saved data windows to their proper
addresses.

About ZAP

The File menu item About ZAP provides a dialog box containing the
configuration, version number and copyright for ZAP.

Exit
The exit menu command closes ZAP and all windows associated with
the current invocation and optionally saves the configuration.
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Utilities Menu

ZAP allows you to integrate and operate your favorite editor and
make facility with the compiler and debugger. You can access several
tools as well a DOS shell from a convenient button bar or pull down
menu. To configure the button bar Cho@mnfigurefrom the

Utilities Menu to open the Tool Editor.

Configure Tools

The Tool Editor allows you to call any DOS or Windows editor by
entering the appropriate editor commands in the Edit field. To call or
switch to an editor with the current source file use the % character to
denote the current source file.

Call Editor

To configure an editor simply enter the appropriate command
to start the editor in the Editor field of the Tool Editor. To open
or switch to the editor from ZAP selectll Editor from the
Utilities Menu to invoke the desired editor.

Edit Current File

To setup an editor to automatically open the source file
currently active in ZAP add the editor command followed by
the % character to denote the current file. Click on the appro-
priate button or sele&dit Current Fileto open the editor with
the current source file.

Compile

Setup the compiler command line in the Compile field of the
Tool Editor including all desired compile time options
followed by a % character. To compile the active source file
click on the Compile button or choo€@mpilefrom the

Utilities Menu.

Compile Debug
Same setup a8ompilewith the addition of the debug option to
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provide source level debug information. To compile choose
Compile Debudrom theUtilities Menu or click on the
Compile Debug button.

Build

TheBuild command can be used to execute a makefile or link
the current application. To configure the build command enter
the desired command in the Build field. To execute the build
command seleduild from theUtilities menu or click on the
Build button.

DOS Shell

To open a DOS Shell. Click on the DOS icon or select DOS
Shell from the Utilities Menu.

= Tool Edit

Edit | d:\cwrighticw |

(Bl i |d:\cwright\cw % |

File
Compile |cx6805 vis % |
Compile for

Debug |chBl35 -¥lg +debug X% |
Build |c|nk -0 outfile hD8 linkfile.Ink| |

Usze % as the Current File Hame
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On-line Help Facility

ZAP provides an extensive help facility. ZAP provides help on C
language syntax and C library syntax as well as how to use ZAP.

Help on Using ZAP

ChooseOn ZAPfrom the help menu to display a list of help topics for
ZAP. Double click on any subtopic to view manual pages on the
topic.

Help on C Library

ChooseOn C Libraryfrom the Help menu to display a list of C
libraries. Double click on any function name to display a manual
page describing the syntax of the function.

Help on C Syntax
Double click on any C keyword or library function to open up a
syntax description window.
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CHAPTER

3

Program Execution

This chapter covers the many different ways to control program
execution, including:

+ Start and Stop Execution

+ Single Stepping

+ Reset and Restart

+ Events and Breakpoints

+ Activate and Deactivate Functions

+ Browser Menu
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Start and Stop Execution

Once an application is loaded into ZAP you have several options for
executing your code. These options are found under the debug menu
and on the Toolbar.

Normal Execution

Normal execution is the continuous real-time execution of the appli-
cation (except with simulation of course). ZAP updates any active
windows whenever execution halts.

Mouse and Menu

To start or resume execution typevhen the Source window is
active or choose Go from tlizebug Menu, Button bar or
Toolbar. This will start execution from the current PC and
continue until an active breakpoint is reached or you select
Stopfrom the Main menu.

Go Till Source Line Short-cut

If you want to execute the program until a particular source line
simply hold down the control key and double click on the
source line number. This can be done from any source window
including C or assembly source browser windows.

Go Editor

The Go Editor allows you to execute your code until it reaches
a specific file, function, line number, address. Choose Go Till
under the debug menu to open the Go Editor.

» Double click on a function name or source file to execute
until the specified function or source file is entered.

* Enter a source line number in the Line Box to execute until
the line is reached.

* Enter an address in the address box to execute until the
address is reached.
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Figure 3-1 Go Editor

Command Window

Typeg in the command window to start or resume execution.
Theg command accepts one of two possible arguments. You
can enter either a number of C lines to be executed or the C line
number to execute tcSee the g command in the “ZAP
Commands” chapter for details.

Stop execution
Mouse and Menu
You can stop execution at any time by clickingSiop or
typing escapén the Main menu. When the program stops all
active or dynamic windows are updated and refreshed.
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Single Stepping

Single stepping allows you to execute one Disassembly instruction or
source line at a time and monitor changes to the system. All active
and dynamic windows are updated after each single step. ZAP offers
several different types of single stepping for greater flexibility. You
can step at the source level or disassembly level, step into or over
function calls and perform conditional stepping. ZAP coordinates the
source display with the disassembly display using color coded
highlight bars. The current source line and disassembly instruction
(PC) is highlighted in the source and disassembly window respec-
tively. ZAP also provides an additional highlight bar which covers
the assembly instructions that make up the current line of source
code. These highlights are continuously updated with all of the single
step methods described below.

Mouse and Menu

» To step one source line and step into active functions
ChooseStepfrom the Debug menu or Toolbar or type
when the ZAP Source window is active.

» To Step one source line and step over function calls;
ChooseStep Overfrom the Debug Menu dgtep Ofrom
the Toolbar.

» To Step one disassembly instruction and step into
functions; Choos8tep Instfrom the debug menu &tepl
from the Toolbar. You can also typ&hile the Disas-
sembly source window is active to step at the assembler
level.

Step Editor

The step editor allows you to perform multiple single steps and
conditional single stepping. Choose step until under the debug
menu to open the step editor.

» Click in the Assembler Box to enable and disable assembly
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level stepping. The default is source level stepping.

» Double click on a function name or source file to single
step until it enters the specified function or source file.

» Enter a number in the count box to perform multiple single
steps from the current program counter.

» Enter a C line number in the Line box to step until the line
is reached.
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Figure 3-2 Step Editor
Command Window

The step command single steps one line of source code. The
step command accepts two optional arguments. The following

examples demonstrate some common uses of the step
command.

See the step command in the “ZAP Commands” chapter for
more details.

» To step one source line and step into active functionsstype
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or stepin the command window.

To step multiple source lines typet where # is the
number of source lines to be executed.

Type so or ostepto step one source line and step over
function calls.

Type si oristepto Step one disassembly instruction and
step into functions.

Typeso put()to step over function calls until the function
put() is encountered.
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Reset and Restart

Reset

Choose Reset from the debug menu to reset the processor or
processor simulation. The Reset command may be disabled in the
Monitor version of ZAP if there is no way to issue a reset through
software.

Go from Reset

Choose&'Go from Reset"from theDebugMenu to reset the processor
or processor simulation and then issu@acommand to start
execution. This option does not affect any events.

Restart

TheDebugmenu itemRestartsets the PC to it's original value after
loading the current application. This command does not affect any
other registers or events.
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Events and Breakpoints

Events and breakpoints are used to control program execution based
on the state of the system. Code Events include breakpoints and
watchpoints.

Code Events

Code events include breakpoints and watchpoints. A breakpoint is
used to stop execution so that the system can be analyzed. A watch-
point is used to temporarily stop execution, perform an action and
then continue execution.

Watchpoint

A watchpoint is used to temporarily stop execution, perform an action
and then continue execution. A watchpoint is the same as a break-
point except that execution resumes after the action is finished. To set
a watchpoint choose “watchpoint” in the “Code Event Editor” or use
the “Watch” command. See the chapter titled “ZAP Commands” for
details. The specification and options for watchpoints are identical to
that of breakpoints. Breakpoints can be converted back and forth to
watchpoints by selecting the watchpoint or breakpoint box in the
code event editor.

Breakpoints

A breakpoint is an event that causes execution of your program to be
interrupted so you can examine the state of the system. You can set an
unlimited number of active breakpoints on any C source line,

address or data object. You can also associate debugger commands,
user commands and complex expressions to any breakpoint. There
are several methods for manipulating breakpoints, choose any of the
following methods.
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Setting/Editing Breakpoints

Mouse and Menu

Double click on any valid line number in the Source
window to set an unconditional breakpoint on a line of
source code. A valid line number refers to a line of source
code that actually produced assembly code and is shown in
bold.

Double click on any bold line number in a source browser
or Event Browser window (See Browsing options for more
information).

Double click on an address in the Disassembly window to
set a breakpoint on an address.

Command window

The b command is used to set and display breakpoints. The
breakpoint command accepts the following syntax:

break [/<options>] [<location>] [{<action}]

See The break command in the “ZAP Commands” chapter for
a complete description.

Typeb:line# in the command window to set a breakpoint
on the line number in the current source file.

Typeb function() in the command window to set a break-
point on every line of the function().

Typeb/4 main():8to set a breakpoint on line 8 of the
function main that will only halt execution every fourth
time the line is executed.

Typeb foo():3 {u i 2}to set a breakpoint on line 3 of
function foo() and perform the action specified inside the
curly braces. In this case, the action is to update variable i
to 2 when the breakpoint is taken.
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Deactivating/Activating Breakpoints

ZAP allows you to deactivate or suspend any breakpoint without
removing it from the system. You can then selectively activate them
as needed. When a breakpoint is deactivated it will not halt or
interfere with execution. Note: The breakpoint highlight will change
colors when you activate and deactivate a breakpoint. Choose any
one of the following methods to activate and deactivate breakpoints:

Mouse and Menu

» To activate or deactivate a breakpoint double click on a
breakpoint line number in the source window or source
browser window while holding down the shift key.

» Double click on an active breakpoint and chooskff
from the pull down menu to activate or deactivate the
breakpoint.

» ChooseBrowsefrom the Events Menu and double click on
a breakpoint while holding the shift key to activate or
deactivate the breakpoint.

* ChooseBrowsefrom the Events Menu and double click on
a breakpoint. Choose on/off from the popup menu to
deactivate or activate the breakpoint.

* ChooseEvents from the Browser meand double click on
an active breakpoint while holding the shift key to
deactivate the breakpoint.

* ChooseEvents from the Browser meand double click on
an active breakpoint. Choose on/off from the popup menu
to deactivate or activate the breakpoint.

Command Window

The Code Event Editor is not available as a Command Window
option.
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Deleting Breakpoints

Breakpoints are completely removed from the system by deleting
them. Choose any of the following methods to delete a breakpoint.

Mouse and Menu

To delete a breakpoint double click on an active or
suspended breakpoint line number in the source window or
source browser window while holding down the control
key

Double click on an active or suspended breakpoint line
number in the source window or source browser window
and choos®eletefrom the popup menu

ChooseBrowsefrom the Events Menu and double click on
a breakpoint while holding down the control key to delete
the breakpoint.

ChooseBrowsefrom the Events Menu and double click on
a breakpoint. Choodeeletefrom the popup menu to
delete the breakpoint.

Choose=vents from the Browser meand double click on
a breakpoint while holding the control key to delete the
breakpoint.

ChoosekEvents from the Browser meauad double click on
a breakpoint. Choodeeletefrom the popup menu to
delete the breakpoint.

Command Window

To delete a breakpoint from the command window you can use
thedel command. The following examples demonstrate the
use of the del command to delete breakpoirge thalel
command in the “ZAP Commands” Chapter for details.

Typedel #where # is the breakpoint number as shown to
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the left of a breakpoint in a Event Browser window.

Typedel * to delete all of the breakpoints from the system.

Code Event Editor

The Code Event Editor can be used to set, suspend and delete
breakpoints. The Code Event Editor also lets you attach an
action to a breakpoint or create a watchpoint. The Code Event
Editor can be opened in several ways. Choose any one of the
following to open the Code Event Editor:

ChooseCode Evenfrom the Events Menu to open up the
Code Event Editor.

ChooseBrowsefrom the Events Menu, double click on a
breakpoint and choodg&dit from the popup window.

Double click on any breakpoint in the source window and
chooseEdit from the popup menu.

Double click on a breakpoint in any source browser
window and choosEdit from the popup menu.

ChooseEvents from the Browser merdpuble click on a
breakpoint and choodg&dit from the popup menu.

Setting Breakpoints

To set a breakpoint using the Code Event Editor choose the
desired conditions and click on OK to set.
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Choose or enter a function name to set a breakpoint on
every line of the function or on function entry.

» ChooséWholeto set a breakpoint on every C line in
the selected function.

» ChooseOn Entryto set a breakpoint on the entry of
the selected file or function.
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Choose or enter a filename to set a breakpoint on every line
of the source file.

Choose Breakpoint to stop execution when the condition is
met.

Choose Watchpoint to silently stop execution, execute the
action (if any) and resume execution.

Hit Count Box - Enter a number in the Hit Count Box to
specify the number of times the breakpoint will be
executed before execution is halted.

Choose Active or Suspended from the Status box to
activate or suspend an the breakpoint or click the ON/OFF
button.

Action Box - Enter any ZAP command or combination of
ZAP commands in the action window to attach an action
to the current breakpoinSee the chapter “ZAP
Commands” for more information about ZAP Commands.
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Code Event Editor I
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Figure 3-3 Code Events Editor

Page 3-14



Program Execution

Displaying and Editing Breakpoints

Active and suspended breakpoints are denoted by a color highlight
over the source line number or assembly address in the Disassembly
window or any Browser window. To display a complete list of all
existing breakpoints choose Browse from the Events Menu or choose
Events from the Browser menu to open up the Event Browser
window. You can click on any breakpoint listed in this window to
activate, deactivate, delete or edit#ee the Breakpoints section of

this chapter for more information on activating, editing and deleting
breakpoints.
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Activate and Deactivate Functions

ZAP gives you the option to selectively activate or deactivate
functions you want to debug. When a function is deactivated you can
no longer step into the function or monitor local variables and the
function will not be included in a source trace display. This allows
ZAP to operate more efficiently and eliminates unwanted information
in the source trace. By default, ZAP activates all functions in your
application that are compiled with the debug option. The status of
each function is listed in the first column of the Function Browser
Window. An activated function is indicated by (on) and a deactivated
function is denoted by an (off) tag.

Mouse and Menu

To activate and deactivate functions simply double click on the
word (on) or (off) in the first column of any function browser
window.

Command Window

To activate a function use the activate commandhea
command uses the following syntax. For more information see
thea command in th&ZAP Commands’chapter.

activ <name_list>

To deactivate a function use the deactivate command da. For
more information see trlecommand in théZAP Commands”
chapter

deact <name_list>

Where <name_list> is one or more function names to be
activated. Thectiv anddeactcommands also accept the
standard wildcard character (*) to denote all functions. For
example:

1. Typedeact foo()to deactivate the function foo().

2. Typeactiv foo() to activate the function foo().

3. Typedeact *to deactivate all the functions in the current
application.
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Browser Menu

ZAP'’s unique browser menu lets you quickly search and monitor
sources, breakpoints, data objects or any memory location.

Event Browser

The Event Browser window displays a list of all existing Events
(active and suspended) This includes code breakpoints and watch-
points. You can click on any event to activate/deactivate, edit or
delete. See the section on Events for more information on setting and
editing events.

m

Figure 3-4 Event Browser Window

Source Browser

Zap's unigue source browser allows you to search and view all of
your source code in multiple discrete windows. You can set, edit and
delete breakpoints anywhere in your code without changing the
source window or the current state of execution. This is done by
double clicking on C line numbers. There are several different ways
to browse your source. Choose any of the following:

File Browser

* ChooseFile List from the Browse Menu to open the File
Browser window. This window contains a list of all the
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source files that make up the loaded application. You can
double click on any source file name to open a source
browser window containing the selected source file.

— File Browser 'I -
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Figure 3-5 File Browser Window

File Browser Dialog

* SelectFile from the Browse Menu to open the File
Browser dialog box. The dialog box contains a list of all
the source files that make up the currently loaded appli-
cation. Choose any source file and click OK to open a
source browser window containing the selected source file.
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Figure 3-6 File Browser Dialog Box
Function Browser

» Chooséd-unction List from the Browse menu to open the
Function Browser window. This window contains a list of
all the source files and functions that make up the loaded
application. You can double click on any source file or
function name to open a source browser window
containing the selected source file or function.
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Figure 3-7 Function Browser Window

Function Browser Dialog

SelectFunction from the Browse Menu to open up the
Function Browser dialog box. The dialog box contains a
list of all the source files and functions that make up the
loaded application. Select any source file or function and
click OK to open up a source browser window containing
the selected function.

FEmar
s ¢
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Any Source

ChooseAny Sourcefrom the Browse Menu to open a standard
Windows browser dialog. You can view any file on your
system. If you open a file that is part of the loaded application
then the C line numbers will be black and you can set break-
points in the file. If the file is not part of the loaded application
then the line numbers will be gray and the file is treated as read
only
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Figure 3-9 Any Source Browser Dialog Box

Memory Browser

The memory browser allows you to examine any valid memory
locations in several formats including a disassembly.

. Chooseviemory from the Browse Menu and select
Datain the Memory Window Configuration dialog
box to display or dump memory.

. ChooseMemory from the Browse Menand select
Code in the Memory Window Configuration dialog
box to disassemble a block of memaory.

SeeDisplaying and Updating Memoiip the chapter 5 (Monitoring
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Application Data) for more details on displaying memory.

Variable Browser

The variable browser allows you to view all of the variables in
the loaded application. There are three different formats you
can use to display the variable information. The Brief format
displays the variable name and type. The Standard format lists
the variable name, type and value and the Full format displays
variable name, type, value and address. There are also four
different display options as described below.

. Chooseln Current Functiorsubmenu to display all
variables local to the current function.

. Chooseln Current Filesubmenu to display all static
variables in the current file scope, global variables
declared in the current file and all variables local to
the current function.

. Chooseln Global Listto display all variables in the
current scope including extern globals, statics and
locals.

Page 3-22



Program Execution

Cross Reference Browser
The Cross Reference Browser displays the calling tree for application

functions.
Function Cross Reference

This dialog window allows you to choose a particular function
to display the cross reference information. Click on a function
name to open a Cross Reference window.
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Figure 3-10 Function Cross Reference Dialog

Cross Reference Window

The Cross Reference Window displays the function calling tree
for a particular function. Double click on a colored function
name to display the cross reference tree for that function.

= Cross Reference

float_math<()
initialire_date(> ] fill_tahle<>
main{> initialize_date{> initialize_date(>
strcpyld

Figure 3-11 Cross Reference Window
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Symbol List Browser (sorted)

The Symbol List Browser provides a list of all global C and
Assembly symbols sorted by address or alphabetically by name.
Double click on any file name to display a source browser window.
Double click on any symbol name and select from the following:

Address of Displays the address of the symbol

Evaluate as Displays the value of the symbol in byte,
word or long format.

Update as Allows you to update the contents of the
symbol as a byte, word or long value.

Set Breakpoint  Sets a breakpoint at the symbols address.

Show Code Displays a disassembly of the symbols
address.
Show Data Provides a data dump staring at the address
of the symbol.
T N |
Lak Li kAl 'K i i ESl&i i ENVLLES LLDn, K2 ) Limial . _l-
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Figure 3-12 Sorted Symbol List
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Symbol Browser

The Symbol Browser window allows you to quickly search through
the symbol table to find the address of a symbol. Simply type the
symbol name or a part of the name to search the list. Click on the
symbol to display the address.
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Map

Choose Map to display the application segments along with their
corresponding starting and ending addresses and segment sizes. This
is identical to selecting Application Map from tRée menu.
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CHAPTER

A

Monitoring Application Data

ZAP offers several advanced features to help you optimize your C
code as well as track down those hard to find bugs. This chapter
includes the following sections:

*

*

*

Monitoring Variables and Expressions
Updating Variables

Evaluating Expressions

Displaying and Updating Memory
Evaluating Assembly Symbols
Displaying and Updating Registers
Displaying the Stack Frame
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Monitoring Variables and Expressions

ZAP provides an extensive monitoring facility. You can monitor or
watch variables one at a time in the Monitors window or view all the
variables in the current scope in the Variable window. Both windows
are updated each time program execution is halted.

Monitors Window

ChooseMonitors from the show menu or simply monitor a variable
or expression and the Monitors window will automatically open.
ZAP allows you to monitor as many variables as you want and
change the display format of any variable.

Adding Monitors

There are several different ways to monitor variables and
expressions. Choose any of the following methods.

Mouse and Menu

To monitor or watch a variable, double click on a variable
name in the source window and chodenitor from the
pop-up menu.

To bypass the pop-up window, double click on a variable
name while holding down the control key.

Drag and Drop - Right Click on the variable name and drag
it to either the monitor window or it's icon on the button
bar.

To monitor an expression, select the entire expression by
dragging with the left button and choddenitor from the
pop-up menu.

To bypass the pop-up window, select the expression while
holding down the control key.

Command Window

Use themonit command with the variable name or expression
to add it to the Monitors window. The following examples
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demonstrate some common uses ofrttomit command.For
more detailed information see th®nitcommand in the “ZAP
Commands” chapter.

Typemonit i to monitor the variable i.

Typemonit /x ito monitor the variable i in
hexadecimal format.

Typemonit &i to monitor the address of variable i.

Typemonit i+1 to monitor the value of the
expression “i+1”

Typemonit /s buffer to monitor the variable buffer
as a string.

Variables and expressions must be in the current scope to be
evaluated or monitored.

NOTE

Monitor Format

ZAP displays all variables in their declared formats by default.
However, you can change the format by double clicking on
any variable name or expression in the Monitors Window and
choosing a format from the pop-up submenu.

Deleting Monitors

» To delete a monitor simply double click on a variable name
or an expression in the Monitors window and choose
Deletefrom the pop-up window.

Address of Source Lines

To display the address of any active line in the source window or
source browser window choose Show->Address from the source
window menu or double click on the line number while holding down

the shift key.
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Updating Variables

ZAP lets you update or change the value of any variable in the current
scope.

Mouse and Menu

To update a variable, double click on the variable name and
choosdJpdatefrom the pop-up window. This opens the
Update dialog box where you can enter a new value for the
selected variable. The entry format can be changed by clicking
on the Format button and choosing the desired format from the
pop-up window. This allows you to enter the new value in any
of the following standard formats. ZAP will make any
necessary conversions.

Character - Enter the desired ASCII character between the
apostrophes.

Octal - Enter an octal value in standard C notation with using a
leading zero.

Decimal - Enter a signed decimal value.
Unsigned- Enter an unsigned value.

Hexadecimal- Enter an hexadecimal value in standard C
notation using a leading Ox. (e.g., 0x100 for hexadecimal 100)

String - Enter an ASCII character string between the double
quotes.

= Update SCCRO

0ok
| x37 |

Cancel

Figure 4-1 Update Dialog Box
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Command Window

Theupdate command is used to update a variable from the
command window. The following examples demonstrate
some common uses of the update commdad.more detailed
information see thapdatecommand in the “ZAP Commands”
chapter.

. Typeupdate i 3or updatei=3to update variable i
to the value of 3.

. Typeupdate buffer “abc” to update the character
string buffer to abc.

. Typeupdatech ‘a’ to update the character variable
ch to the letter a.

Page 4-5



Monitoring Application Data

Evaluating Expressions

ZAP allows you to display the value of any variable or expression in a
temporary pop-up window. This feature helps avoid cluttering up the
Monitors window with variables and expressions that you only need
to display occasionally.

Evaluate Expression

There are several different ways to evaluate variables and expres-
sions. Choose any of the following methods.

Mouse and Menu

To evaluate a variable, double click on a variable name in
the source window and choogaluatefrom the pop-up
menu.

To bypass the pop-up window, double click on a variable
name while holding down the shift key.

To evaluate an expression, select the entire expression by
dragging with the left button and chodSealuatefrom the
pop-up menu.

To bypass the pop-up window, select the expression while
holding down the shift key.

Command Window

Use the eval command with the variable name or expression to
evaluate it. The following examples demonstrate some
common uses of the evabmmand.For more detailed infor-
mation see thevalcommand in the “ZAP Commands”

chapter.

Typeeval i to evaluate the variable i.

Typeeval /x i to evaluate the variable i in hexadecimal
format.

Typeeval &ito evaluate the address of variable i.
Typeeval i+1 to evaluate the value of the expression “i+1"
Typeeval/s buffer to evaluate the variable buffer as a
string.
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Displaying and Updating Memory

ZAP allows you to display, disassemble or modify any block of
memory. This can be done using either the Browse or View menu.
ChooseMemory from the Browse Menu or the Show Menu to open
the Memory Window Configuration dialog box. This box requires

you to enter the starting address for the memory block to be
displayed. You also need to choose whether you want the contents of
the memory block disassembled (Code) or a raw data dump (Data)

Address: I]xEI]I]I]|

Format Ok

OQude

@ Data Cancel

Figure 4-1 Memory Window Configuration Dialog Box

Disassembling Memory

ChooseCodeunder format in the Memory Window Configuration
Dialog box and enter a valid code address in the Address box. This
will open a browser window containing a disassembly of the
specified memory block including symbols. You can set a breakpoint
by double clicking on any memory address in the disassembly.

Displaying Memory

To produce a raw data dump Cho@sgta under format in the
Memory Window Configuration dialog. This will bring up the Data
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Configuration dialog box which is used to format the Raw data. To
configure the data display, you have the following options:

1.

-
Sire Formas ABcin

i Byt D

e 2 e -

.7 Lo 7 Hew

Address - Enter the desired starting address or symbol for
the memory dump in the address box.

Size - Choose a convenient data size for the display. Byte,
word or long word.

Format - Choose the desired display format; Octal, decimal
or hexadecimal.

ASCII - Choose Yes to include an ASCII display next to
the memory dump. Choose No to show only the numerical
display

) Yns

Figure 4-1 Data Configuration Window

Updating Memory

If you configure the display for data you can double click on any
value in the numerical or ASCII display to update. For example to
update address 0x00410 in the display below, double click on the
value b000 next to address 0x00410 and enter the new value.
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Figure 4-1 Data Display Window

Fill Memory

The data display can be used to fill memory with a pattern. Choose
fill from the Data display menu to open the Memory fill window. In
the memory fill window you can enter a fill pattern or choose random
to have ZAP create a random pattern. Select the data size and the
address range in the “To” and “From” boxes. Choose verify to have
ZAP read back the filled memory and verify that it is correct. See the
Fill command in the chapter “ZAP Commands” to use the command
window or debugger script to fill memory.
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Figure 4-1 Data Fill Window
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Saving a Memory Dump to a file

Click onDump in the Data Display window to save the memory
dump to afile. Enter the address range in the Memory Data Dump
window and enter or select a file to save the dump.

Display Highlights

ZAP provides a convenient way to keep track of memory modifica-
tions using colored highlights to denote memory changes. Memory
highlights are updated each time execution is halted and cleared upon
reset.
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Evaluating Assembly Symbols

ZAP allows you to display the value of any global symbol in a
temporary pop-up window. Double click on any global symbol in
any source window to open popup window with the following

options.

Address of

Evaluate as

Update as

Set Breakpoint
Show Code

Show Data

Displays the address of the symbol. You can
also get the address by holding down the
shift when double clicking on the symbol.

Displays the value of the symbol in byte,
word or long format.

Allows you to update the contents of the
symbol as a byte, word or long value.

Sets a breakpoint at the symbols address.

Displays a disassembly of the symbols
address.

Provides a data dump staring at the address
of the symbol. Alternatively hold down the
control key when double clicking on the
symbol.
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Displaying and Updating Registers

ZAP provides a window display dedicated to the CPU registers. The
Register window allows you to display and update any of the
processor registers with a point and click. ZAP also highlights
changes to the CPU registers each time the Program Counter is incre-
mented so you can track CPU changes instruction by instruction. The
register display is updated each time program execution is halted or
after every single step.

Page 4-12

To open and close the Register Window, Chd®egisters
from theShow menwr type thee command in the
Command Window. See thecommand in the “ZAP
Commands” chapter for more information.

To update a register directly simply double click on the
value of the register and enter a new value.

To update a register with a symbol or function double click
on the name of the register to open the update register
window. Click on Symbol to open the Symbol Browser or
click on Function to open the Function Browser Window.
Select the desired symbol or function to update the active
register.

= Update $ppc

‘ C Function Cancel

Figure 4-1 Update Register Window
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Displaying the Stack Frame

The Stack Window displays the current stack frame and
arguments with the active function nested to the bottom of the
display. The stack display is updated each time program
execution halts. The Stack Window allows you to double click
on any function in the stack frame to open up a Source Browser
Window containing that function. To open and close the stack
Window choosestackfrom theShow menwor use thel
command.For more information about the Toggle Stack
Display command, see tiecommand in the “ZAP

Commands” chapter.

= stack =] E3

Save Print

maini)
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Figure 4-1 Stack Window
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CHAPTER

5

Advanced Topics

ZAP offers several advanced features to help you optimize your C
code as well as track down those hard to find bugs. This chapter
includes the following sections:

+ Simulated I/O
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Simulated 1/0

ZAP provides a general facility to perform simulated 1/O using files
stored on your computer. Simulated I/O is a means by which you can
bring input right into you embedded system or send output from your
system to data files on your computer. These files can be created and
manipulated with standard computer utilities like spread sheets and
data bases and math programs. Embedded systems development has
always had one big problem. It is difficult to get data into the system
to test the algorithms until most or all of the hardware is finished.
Simulated I/O bridges the gap. You can create data or stimulus files
that can be read into the system from anywhere in the system as easily
as setting a watch point.

Simulated I/O uses the fopen, fclose, fread and fwrite commands in
conjunction with the watch point mechanism. These commands can
also be used directly in the command window for you just want to get
or output something one time or periodically throughout a command
script. To setup the mechanism follow the steps below.

1. Open the files you want to use for simulated 1/O using
fopen. (e.g. fopen /c:1 c:\test.out)

2. Seta watch point in your application where you want to
send or receive data. This is often in a function that reads
or writes to a hardware I/O register. Note the application
must be able to execute to this location. You may need to
set additional watch points to set some conditions so
execution will get the desired location.

a) Enter the desired I/O command in the action box of the
watch point edit window. e.g. fwrite /c:1 “%d"var

3 Set a breakpoint to stop the application after the I/O is
finished.

4. Execute the application to the breakpoint or till the end.

5. Close the I/O files using the fclose command. (e.g. fclose /
c:l)
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In general, you'll want to create a script to setup the watch points with
the appropriate actions for your specific application. See the chapter
“ZAP Commands” for details on the commanmdsord, input,

watch, fopen, fclose, fread and fwrite.

The following example uses an input script to open two files and set
two watch points to simulate input from a file process the input using
the target processor and then output the result to a file on the host
computer.

Example

The file below is a simple program which reads in a couple of
integers adds them together and outputs the result to a file as
formatted text using printf.

#include <stdio.h>

int a,b,sum;
int getinput(void);
int putchar (char c);

void main(void)
{
a = getinput();
b = getinput();
sum = a+b;
printf(“The result of a+b is %d \n”,sum);
END_MAIN: ;
} // END MAIN

The following routines are dummy input and output routines. These
could be any I/O routines. The simulated I/O mechanism is created
by the watch points with the fread and fwrite commands. Note the
labels OUTCH and INCH. These are standard C goto labels.
Although, the goto feature in C has traditionally been taboo, using
just the labels is useful for creating debugger breakpoints and watch-
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points. These labels are treated as local symbols and allow you to
create scripts which contain relative break and watch points within a
function. Without using such labels you would need to know which
line of the function you want to set the break and thus if you modify
the source file you may need to modify any scripts containing break-
point in that function.

NOTE
If you want to use the local labels (goto) described above infa
ZAP script you need to compile with extra debug information.
Use the -xx option on the preprocessor/parser. for example
cx6812 -pxx +debug -vl acia.c
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The following is a ZAP input script that will load the example appli-
cation open the two /O files, set two watch points to perform the 1/0O
simulation and then execute the application. Each time the fread
watchpoint is taken the next value in the file is read in to simulate a
flow of input. The fwrite watchpoint routine appends output to the
file and so as not overwrite the previously written information.
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The file data_in.txt contains the following data before and after the
script is executed:

After executing the script the file data_out.txt is created and contains
the following:

If you want to simulate your hardware controlled 1/O registers you
may need to add additional watch points to set the proper conditions.
For example, it is common in an SCI routine to loop on the transmit
enable to make sure the hardware is ready to receive a character.
When simulating the SCI you would need to either #ifdef around the
loop or set an additional watch point and set the condition. e.g.

watch putchar():SCI_LOOP {update SCSI = (SCSI ~ SCTE)}




CHAPTER

6

ZAP Commands

ZAP provides an extensive command set which duplicates the
functionality of many of the mouse selections and popup windows.
The command Window can also be used to create an automated
debugging session by loading an input command file. An input
command file may contain any valid ZAP commands. This chapter
describes the ZAP commands and their syntax and includes the
following sections:

*

*

*

Command Line Syntax

Specifying Memory Locations and Registers
User defined variables

Entering ZAP Commands

Command Descriptions
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Command Line Syntax

All ZAP commands use the following basic syntax:

<command_name> [/options] [<argument>] [<argumen#>]

<command_name>specifies a ZAP debugger command.
Commands must be separated from its options and arguments by one
or more spaces or horizontal tabs.

<options> specifies extra options for the command. Each option is
preceded by a forward slash (Boptions>must be placed after the
<command_name>, but before the <argument>

<argument>specifies an optional location within your C or assembly
language source code, a data object, an unsigned decimal integer, a
memory address, or a C language expression. The possible forms that
<argument>can take are described below. The argument must

follow any specified options with one or more spaces or horizontal
tabs.
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Specifying Memory Locations and Registers

Many ZAP commands require or accept gargument>. An

argument may be a constant, internal processor register, memory
location, file name and line number, function name or variable name.
The argument command language accepts many C style expressions
and operators so objects may be accessed directly or indirectly.

» Constants and Expressions
» Target processor’s registers
» Source files and Functions

« Data objects and Pointers

Constants and Expressions

ZAP commands accept any legal C constant and many C operators
and expressions. ZAP also accepts binary constants using the Ob
prefix notation.

Binary Constants - Ob prefix (e.g. 0b1011)
Decimal Constants - standard notation (i.e no prefix)
Hexadecimal Constants - Ox prefix (e.g. 0x1AB)

Octal Constants - 0 prefix (e.g. 0765)

Register Manipulation

A register specification must have the following form:

$<register_name>

where<register_name>follows the naming conventions of the
processor’s manufacturer. A register specification is identified by its
leading$ character. You can use any CPU register listed in the
register window simply by prefixing it with a $.
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User defined variables

ZAP allows the user to define any number of user defined variables.
A user defined variable is a symbol defined and recognized by ZAP
for use in expressions. A user defined symbol is always prefixed with
the ‘.’ character. To create a user defined variable simply use it in an
expression. If it doesn't exist it will be created with an initial value of
zero. For example:

To create the variable .temp and set it equal to the constant 10 you
could write:

ZAP> eval .temp=10

To set the variable .temp equal to the program variable “varl”:

ZAP> eval .temp=varl

To create and set the variable .tmp_cc equal to the condition code
register and test .tmp_cc to see if interrupts are enabled:

ZAP> eval .tmp_cc=$cc
ZAP> if (.tmp_cc ~ 0x8) mess “interrupts disabled\n”
else mess “interrupts enabled\n”

Source files and Functions.

ZAP command arguments can also be a location specifier designating
one or more valid lines of C or assembly language source code. A
valid line of source code is defined as any line that is associated with
an executable piece of code which is compiled in debug. A source
line designation can have one of the following forms:

file_name:line_number- Specifies a line number in the given source
file. e.g To set a break point on line 55 of testt.c the command would
be:

break test.c:55
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file_name: - Specifies all executable C lines in the named source file.
e.g To set a break point on all source lines in a particular source file
the command would be:

break test.c

function():line-number - Specifies a line number in the named
function. The current source file is assumed. e.g. To set a breakpoint
on a specific line of a function in the current source file the command
would be:

break main():38

function() - Specifies all executable C lines in the named function.
e.g. To set a breakpoint on all source lines in a specific function the
command would be:

break main()

NOTE

Only source line numbers which correspond to actual code are
recognized by the line number specification.

Data Objects

A location specifier for <argument> that designates a data object can
have any one of the following forms:

data_object_name Specifies a global data object. e.g. To evaluate
a global variable named bar you would type:

eval bar

file_name:data_object_name Specifies a static variable with file
scope. e.g. To evaluate a file static variable bar when the necessary
file is not in the current scope:
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eval test.c:bar

function():data_object_name- in scope of function named. e.g. To
evaluate a variable “tmp” local to the function main():

eval main():tmp

[:]data_object_name - scope of current function. e.g. To monitor
the local variable “i” while it is in scope:

monit :i

number - explicit constant specified in any of the following formats:
hexadecimal (0x100), decimal (16), octal address (020) or binary
(0b10000)

expression -C language expression

A data object name is an identifier currently in scope as a data object.
You can change the current scope withrtivecommand. You can
specify a data location using a C expression involving register values,
variable names and values, constants and C language operators,
assuming that the result is an addressable object, described as a
LVALUE in C parlance

Pointer Indirection

The debugger can access data objects both directly and indirectly by a
pointer, as in the C language itself.

You can specify indirection on a pointer data object only as many
times as you specify the pointer attribute in your original declaration.
If you request too many levels of indirection, the debugger prints an
error message indicating a syntax error.

You can use any C expression, referencing structure field through
pointers while you respect the correct C syntax. The expression
evaluator checks for almost the same errors that your C compiler
does.
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Entering ZAP Commands

You enterZAP commands at the “ZAP>" prompt.

You terminate each command with a carriage return, newline, or
linefeed characterZAP allows you to string several commands
together. To specify multiple commands in response to a single
prompt, type each command in the usual way and separate each
command with a semicolon *;’ character. A whitespace character on
either side of the semicolon is option@AP splits multiple

commands on an input line and performs each operation separately,
just as if you had entered each command in response to a separate
prompt.
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Command Descriptions

All commands described are documented in a similar fashion to facil-
itate quick reference. The name of the command appears at the top
outside corner of the page on which it is described. Its name and a
brief description of the action it performs appears at the top of the text
under the headinblame A brief synopsis, under the heading

Syntax, describes the command syntax and the options and param-
eters it accepts. In this context, a name enclosed in angle brackets,
such as<argument>, is an element which is defined elsewhere in the
discussion or is self evident. In the case of multiple options, the
description of each command tells you which options may be used
together.

The character wild card character *’ directly to the right of an
element denotes an <argument> that may appear one or more times.
The command del, for example, allows one or more events to be
deleted. e.g. To delete all events you would type:

del /e *

Enter all other characters in the synopsis as shown.

A more detailed description of the command and the options and
parameters it accepts follows under the heaBingction. The
default value for each option, if any, is specified here.

One or more examples follow the command explanation, under the
headingexample. The examples given are not intended to represent
the precise behavior @AP for any specific processor or with any
specific program.
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ZAP Commands

The following commands are available in ZAP Detailed descriptions
of each command follows the summary.

* - print comment

activ - activate function

break - set or modify breakpoint

deact- deactivate function

del - delete breakpoint, monitored or user function
disa - toggle disassembly window

dump - dump memory as byte word or long

eval - evaluate an expression

fclose- Close an open file (as a channel) that was used for I/O
files - show source files for application loaded

fill - block fill memory

fopen - Open a file (as a channel) for input or output

fread - Read from an open file (channel) and update program
variables

fwrite - write to an open file (channel)

frame - dump the stack to the command window
funcs- show functions for application loaded
go - start or resume execution at the current PC
hist - create a history file

if - test program condition

input - load a zap command file
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istep - step at the disassembly level through the program
mess- print a formatted message

load - load a file

monit - monitor an expression

move - move in stack frame

ostep- step over at the source level and step over function calls
output - redirect commands and results to a file

path - set the search path for source files

print - print a file or function

quit - quit zap

record -record a session for playback

regs- dump registers to the command window

rem - print comment

remove- delete file

reset- execute a target reset

stack - show stack

s - step at the source level through the program (enters active
functions)

si - step at the disassembly level through the program
So- step over at the source level and step over function calls

step- step at the source level through the program (enters active
functions)

u - update variable

update - update variable
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vars - Open a variable browser window
watch - watchan expression

wstack - toggle the stack window
wregs- Toggle the register window

T - toggle stack frames status display
update - update a data object

write - save events or monitors

X - evaluate an expression

zero - clear all events, monitors or reset the processor

Page 6- 11



ZAP Commands - *

*
Description
Comment
Syntax
Function

* allows you to write a comment, mainly in a command file or a
function. The content of the remaining text up to the end of line is
ignored by the debugger.

Example

In a command file:

Alias - REM

Comments may be created with either the asterisk (*) or the command
rem.
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activ

Description

Activate a function

Syntax

activ <name_list>

Function

Theactivcommand is used to activate a function, i.e. to make it
possible to debug it usingAP. By default, all functions that have
been compiled for debugging are activatedBy?. You can
deactivate a function with thdeeactcommand; to reactivate it again,
you use thectivcommand. A name listis composed of one or
several function names, with their parenthesis and :, separated by
commas. Typing a star *' instead of aname_list>will activate all
possible functions.

Once a function is deactivated, it behaves as if it had NOT been
compiled for debugging.

The fewer active functions, the quick&kP is able to work. So once
a function has been tested it is worth deactivating it, thus allowing
you to focus more quickly on debugging the remaining functions.

Example

To activate function fact:

ZAP> activ fact():

To activate function fact and foo:

ZAP> activ fact():,foo():
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break

Description

Set, modify or display breakpoint event

Syntax

break [/<options>] [<location>] [{<action}]

Function
Thebreak command sets or displays the “breakpoin®latation>.

A breakpoint is an event that causes execution of your program to be
interrupted so you can examine its state. You can set a breakpoint on
a C source line(s) or an absolute address. Program execution will be
interrupted when control passes to that line or address.

A breakpoint can be set on a range of lines rather than on a single line.
Ranges of lines are specified using theharacter. For example if

you want to set a breakpoint on lines 20 to 35 of function main() you
would type:break main():20:35 . Typing for exampl@reak

main():34  sets a breakpoint on lir82 of main() only.

Options

can be used to specify an optional count, which specifies the
number of times the breakpoint must be reached before it halts
execution. It is then possible for example to set a breakpoint when a
particular C line has been executed a specific number of times.

Reactivate a suspended breakpoint

Suspend an active breakpoint. The breakpoint is still set, but is not
active and will not cause execution to stop.
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WheiZ AP reacheslocation> during program execution
<count> number of times, it performs the specifiedction>.

<action> can be any vali@dAP command or set of commands. The
default <action> is to stop, refresh any open windows and prompt
for command input.

If you do not specifiklocation>, ZAP lists all active breakpoints.
The display of a breakpoint includes various information:

(1) First the breakpoint number between parenthesis, this number will
be used to delete the breakpoint.

(2) The<location> associated with the breakpoint.

(3) If there’s an <action> associated with the event it will be
displayed inside curly braces {}.

(4) Next ZAP displays either (User) or (Internal). This denotes
whether the breakpoint was set by the user or the debugger.

(5) Hit count and hits left. ZAP displays the count associated with the
event and the number of hits left on the event.

(6) The last item in the display is the Status of the event. The eventis
either (on) meaning the event is active and will be taken or (off)
meaning the event is suspended and will not be taken.

(user) to indicate that the breakpoint has been set by the user or
(internal) to indicate that the breakpoint has been sgiiRjtself for
performing its work; and then the count associated with the break-
point and the number of times left before the breakpoint will be taken.

Examples

To set a breakpoint at C source line 12, in functiair

ZAP>break main():12
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The debugger will display:
(xx) test.c main():12 {} (user)(count = 1, left = 1) (on)

To set a breakpoint on every C line of functiestr()

ZAP>break lenstr()

The debugger will display
(xx) test.c lenstr():22:34 {} (user)(count=1, left=1) (on)

To set a breakpoint on any line of fitain.c

ZAP>break main.c:

The debugger will display
(xx) main.c: any line {} (user) (count = 1, left = 1)

To modify the above breakpoint with a count of 4:

ZAP>break /c:4 main.c:

The debugger will display:
(xx) main.c: any line {} (user) (count = 4, left = 4) (on)

To attach an action to the above breakpoint:

ZAP>break main.c:{<action>}

The debugger will display:
(xx) main.c:any line{<action>}(user)(count=4, left=4) (on)

To cancel the action attached to the previous breakpoint:

ZAP>break main.c {}

The debugger will displays:

(xx) main.c: any line {} (user) (count = 4, left=4)
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To set a code execution breakpoint at the address 0x100:
To list all events currently set:

Alias - b

Breakpoints can also be set using the b command line option.
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deact

Description

deactivate a function

Syntax

deact <name_list>

Function

The deact command is used to deactivate a function, By default, all
functions that have been compiled for debugging are activated by
ZAPR You can deactivate a function with ttheactcommand; to
reactivate it again, you use thetivcommand. A name listis
composed of one or several function names, with their parenthesis
and :, separated by commas. Typing a star **’ instead of a
<name_list>will activate all possible functions. Once a function is
deactivated, it behaves as if it had NOT been compiled for debugging.

The fewer active functions, the quick®kP is able to work. So once
a function has been tested it is worth deactivating it, thus allowing
you to focus more quickly on debugging the remaining functions.

When debugging on real hardware it is a good idea to deactivate
interrupt service routines once they are debugged to avoid getting
stuck in the interrupt routines.

Example

To deactivate function fact:

ZAP> deact fact():

To deactivate function fact and foo:

ZAP> deact fact():,foo():
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del

Description

Delete breakpoint, monitor or user function

Syntax

del [/options] <argument>

Function

Thedel command deactivates a function, deletes a breakpoint,
monitor or user function depending on the option used. The default
option is /e to delete an event. <argument> can be either the event
number as shown in the breakpoint->browser or the <location> used
to create the breakpoint.

Options

le | delete one or several breakpoints or watchpoints.
<number_list>is a list of breakpoint numbers, as displayed by the
break command, separated by commas.

/m delete one or several monitorhiumber_list>is a list of
monitor numbers, as displayed in the monitor list, separated by
commas. You can remove a monitor even if it is out of scope.

You can specify an asterisks **" as a wildcard as the only argument.
In that case, all objects are deleted.

Examples

To delete all events:

ZAP> del /e *
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To delete a breakpoint set at foo()

To set a code execution breakpoint at the address 0x100:

To delete the absolute breakpoint above:
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disa

Description
Toggle the disassembly display

Syntax

disa

Function

Thedisacommand toggles the assembler source display window
starting at the current PC address. Assembler lines corresponding to
the current C source line are highlighted in yellow, default.

Page 6- 21



ZAP Commands - dump

dump

Description

dump memory to the command window and output file.

Syntax

dump /[options] [<address>] [<address>]
dump /[options] [<address>],[bytes]

Function

Thedump command instructs the debugger to dump memory to the
command window and output file. ZAP accepts an address range or
a specified number of bytes for the display. Note: ZAP will always
dump memory one whole line at a time. i.e. ZAP will always dump
at least 16 bytes.

Options
/b for byte output
/w | for word output
/I for long word output.
If:i<format > display format.
b Display in binary format
d Display in decimal format
h Display in hexadecimal format

0 Display in octal format
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Examples

To dump memory at Ox1EF to 0x200 in decimal words

ZAP>dump /f:d /w Ox1EF 0x200

this will display:

Olef 17748 17442 34182 29240 09029 18006 34696 34901
01ff 21625 39253 21283 09574 21926 22050 58147 08995

To dump at least 20 bytes of memory at Ox1EF in hexadecimal words:

ZAP>dump /f:h /w Ox1ef,0x20

this will display:

Olef 6a6b 534b 4b4c 444b 736b 6c6c 6d6d 636b
01ff 6b09 776f 6b6f 0977 6b65 6466 6369 7365
020f 6866 696b 6a09 776a 646e 0977 6f70 6966
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eval

Description

Evaluate an expression

Syntax

eval /[options] [<expression>]

Function

Theeval command instructs the debugger to evalsatgression=>

An <expression>is any combination of variables, constants and
operators following the same syntax rules as a standard C expression,
including array and structure indexing.

The expression and its result value are displayed with the type of the
result. If no option is specified, pointers and addresses are displayed
in hexadecimal, and signed and unsigned types are displayed in
decimal. You can force a specific display option using one of the
following extensions:

Options
/b for binary output.
/c | for char output.
/d  for signed decimal output.
If:<size>| force a size at symbol.
b Display a byte at address of <expression>

w  Display a word at address of <expression>
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[ Display a long at the address of <expression>

/h  for signed hexadecimal output with no leading Ox.
/o for octal output.

/g for no output. There is no display. This is useful to create silent
breakpoints or user functions, when the expression is an assignment.

/s for string output.
/u  for unsigned decimal output.

Ix | for hexadecimal output. The value is prefixed by “0x”.

Examples

To evaluate a C variabtebi]:

ZAP>eval tabli]

this will display:
tab[i] = 10

To evaluate a C structure membest.memt

ZAP>eval test. mem1

this will display:

test.meml1 = 30
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To evaluate the address of the assembly variatde in hex where
_foo is at 0x100 and at address 0x100 is: OxF

ZAP>eval /x _foo

this will display the address of the symbdioo:
_foo = 0x100

To evaluate a byte sized assembly variable in hexoat

ZAP>eval /x [f:b _foo

this will display a byte at the address of _foo:
[_foo].b = OxF

Alias - x

Thex command is an alias for eval.
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files

Description

List files used to build program

Syntax

files

Function

files will list the files that have been linked together to obtain the
program you are currently debugging. It might be helpful to check
that you have all the source files needed.

See Also

funcs
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fill

Description

fill memory with specified value(s) starting at <address>.

Syntax

fill /[options] [<address>] [<address>] <value>
fill /[options] [<address>],[bytes] <value>

Function

Thefill command instructs the debugger to fill memory with the
specified value or with a random fill pattern. ZAP accepts an address
range or a specified number of bytes for the display.

Options
/b for byte fill
/w for word fill
/I for long word fill
Ir  for a random pattern fill

Iv | requires ZAP to verify the fill pattern by reading back the
memory and comparing it to the fill pattern.

Examples
To fill memory at OX1EF to 0x200 with the 2 byte value OXAABB

ZAP>fill /w Ox1EF 0x200 OXAABB
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To fill 40 bytes of memory starting at 0x100 with the long value
OXAABBCCDD:

ZAP>fill /1 0x100,20 OXxAABBCCDD
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fclose

Description

Closes an open I/O channel which in turn closes the file associated
with the channel.

Syntax

fclose /c:<number>

Function

Thefclosecommand closes the specified I/O channel which results in
the closing of the corresponding data file. Type the “fclose”
command, followed by the channel you want to close (/c:<number>)
Where /c:<number> is required and <number> is an integral constant
corresponding to an open channel.

Example

To close channel 1, which corresponds to the file “foo.txt”:

ZAP> fclose c:1

This closes the file “foo.txt” and channel one so both can be opened
and used again

Example

To open the file c:\test\data.txt and associate it with channel 4.:

ZAP> fopen /c:4 c:\test\data.txt

Channel 4 can now be used by fread to bring data into the application
from a file outside the application or fwrite to send data outside the
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program to an external file.

To read data in from channel 4 and store the data in program variables
chl and ch2.

ZAP> fread /c:4 "%d %d"chl,ch2

This will read the first two bytes of “c:\test\data.txt” and store them in
program variables chl and ch2 respectively.

To close the file “c:\test\data.txt” type:

ZAP> fclose /c:4

See Also

fopen, fread, fwrite
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fopen

Description

Open a file and associate with an I/O channel for simulated input and
output.

Syntax

fopen /c:<number> <filename>

Function

Thefopen command opens a file and associates it with an 1/0 channel
to be used by the fread and fwrite commands. Each I/O channel can
be associated with only one file at a time. Type the “fopen”
command, followed by an unused I/O channel (/c:<number>) and
then a legal<filename> . Where /c:<number> is required and
<number> is an integral constant.

The local path fokfilename> is the ZAP executable directory.
<number> is an integral constant

The /c option is used to specify the channel to be associated with the
specified file. This option is required.

Options
/a  Open and append to existing file if <filename> already exists.

By default, ZAP opens and overwrites the <filename> if it already
exists.
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Example

To open the file c:\test\data.txt and associate it with channel 4.:

ZAP> fopen /c:4 c:\test\data.txt

Channel 4 can now be used by fread to bring data into the application
from a file outside the application or fwrite to send data outside the
program to an external file.

To read data in from channel 4 and store the data in program variables
chl and ch2.

ZAP> fread /c:4 "%d %d"chl,ch2

This will read the first two bytes of “c:\test\data.txt” and store them in
program variables chl and ch2 respectively.

To close the file “c:\test\data.txt” type:

ZAP> fclose /c:4

See Also

fclose, fread, fwrite, rewind
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fread

Description

Fread from an open I/O channel which corresponds to a file previ-
ously opened by the command “fopen”

Syntax

fread /c:<number> “format” <expression>

Function

Thefread command reads data from a file via an associated 1/0
channel and stores the data into program variables according to the
format specification. The format specification is similar to the ANSI
C scanf function. The format string is followed by zero, one or
several expressions, separated by spaces or by commas.

The format may contain symbolic characters (escape sequences) and
several conversion sequences composed with gaharacter

followed by a single letter. Each converter will correlate to an
expression from the command line, evaluate it, and insert it in the
output, converted as requirdetead accepts the following format
converters:

%d Data is read as a signed decimal.

%u Data is read as an unsigned decimal.

%Xx Data is read as a hexadecimal value without the Ox prefix.
%0 Data is read as an octal value without the prefixeddhy “

%c Data is read as a single character. There is no special
replacement for control characters. They are displayed as received.

Page 6-34



ZAP Commands - fread

Fread does not expect single quotes around the character.

Example

To open the file c:\test\data.txt and associate it with channel 4.:

ZAP> fopen /c:4 c:\test\data.txt

Channel 4 can now be used by fread to bring data into the application
from a file outside the application or fwrite to send data outside the
program to an external file.

To read data in from channel 4 and store the data in program variables
chl and ch2.

ZAP> fread /c:4 "%d %c %x"chl,ch2,inl

This will read the first three bytes of “c:\test\data.txt” and store them
in program variables chl, ch2 and inl respectively. If the file
“c:\test\data.txt” contains the following:

12 a fe
20 b ff

The first time the fread command above is executed

chl is setto 12
ch2 is setto ‘a’
inl is set to Oxfe

The second time fread command above is executed

chl is set to 20
ch2 is setto ‘b’
inl is set to Oxff

ZAP will continue to increment the file pointer in order to read new
data until the end of file is reached. If you want to start back at the
beginning of the file either rewind the channel or open and close the
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channel and file.
To close the file “c:\test\data.txt” type:

See Also

fopen, fclose, fwrite, rewind
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fwrite

Description

Write to an open I/O channel which corresponds to a file previously
opened by the command “fopen”

Syntax

fwrite /c:<number> “format” <expression>

Function

Thefwrite command writes data from the loaded application or
directly from the ZAP command window via an associated 1/O
channel. Fwrite formats the data in the output file according to the
format specification. The format specification is similar to the ANSI
C printf function. The format string is followed by zero, one or
several expressions, separated by commas. The format string may
contain symbolic characters (escape sequences) and several
conversion sequences composed dbacharacter followed by a
single letter. Each converter will correlate to an expression from the
command line, evaluate it and convert it if necessary and insert it in
the output file Fwrite command accepts the following format
converters:

%d Data is output as a signed decimal.

%u Data is output as an unsigned decimal.

%x Data is output as a hexadecimal value without the Ox prefix.
%0 Data is output as an octal value without the prefixed®y “

%c Data is output as a single character. There is no special
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replacement for control characters. They are displayed as received.
Fread does not expect single quotes around the character.

Example

To open the file c:\test\data_out.txt and associate it with channel 4.:

ZAP> fopen /c:5 c:\test\data_out.txt

Channel 5 can now be used by fwrite to output data from the appli-
cation to a file outside the application.

To write the value of program variables chl, ch2 and inl to channel 5
and thus out to “c:\test\data_out.txt".

ZAP> fwrite /c:5 "%d %c %x"chl,ch2,inl

If the program variables have the following values when the fwrite is
executed:

chl=25
ch2 ='¢e’
inl = OXAB

The following will be output to “c:\test\data_out.txt”:
25e AB

If the same fwrite is executed again without closing the channel then
ZAP will append to the same file. If the program was executed and
the variables have changed then the new values will be output.

ZAP will continue to increment the file pointer in order to read new
data until the end of file is reached. If you want to start back at the
beginning of the file either rewind the channel or open and close the
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channel and file.

ZAP> rewind /c:5

To close the file “c:\test\data_out.txt" type:

ZAP> fclose /c:5

Example 2

To write the value of program variables ch1 and ch2 to channel 5 with
extra formatting.

ZAP>fwrite /c:5 "variables ch1=%d\n ch2=%d\n" ch1,ch2

If program variables ch1=5 and ch2=7 then the output file would look
like the following:

variables ch1=5
ch2=7

See Also

fopen, fclose, fwrite, rewind
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frame

Description
List the functions in the current stack frame with arguments.

Syntax

frame

Function

Theframe command will display the functions currently in the stack
frame with their corresponding arguments. The list will be captured
in the command window and the file specified by the output
command if any.
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funcs

Description

List functions used to build program

Syntax

funcs

Function

funcswill list the functions that have been linked together to obtain
the program you are currently debugging. It might be helpful to check
that you have all the source files needed, and to know where a
particular function is located.

Functions will be displayed by source file. Each function is prefixed
by a word indicating whether it is active (see active command).

(on) Indicates that the function is activated, but breakpoints are not
yet loaded

(act) Indicates that the function is activated, and breakpoint have
been loaded.

(off) Indicates that the function is deactivated.

This information is useful mainly for an emulator or board version,
and the effects associated with these states depends on the actual
target system.

Example

To list the functions of a specific file, type

funcs
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Produces the following output to the command window:

Functions in file: test.c
(on) extern void main() at Oxa71

(on) extern void init() at Oxadb

See Also

files
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go

Description

Start or Resume execution

Syntax

go [<location>]

Function

Thegocommand starts or resumes program execution. Once begun,
execution will continue until program termination or uilP
encounters a breakpoint. If you specifglacation>, execution is
stopped when this location is reachelbcation>may be any line or
object suitable for a breakpoint.

Example

The following command will execute the code starting at the current
PC until the function main() is entered.

go main()
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Description

Test program condition.

Syntax

if ( <condition>) <CMD> ; else <CMD> ;
if (<condition>){<CMD>; <CMD2>;} else{<CMD>; <CMD2>; }

Function

Theif command tests a program condition and executes a ZAP
command(s) if the condition is true and can optionally execute
another ZAP command(s) if the condition is false. <CMD> may be
any ZAP command. Thi& command can be used as part of an action
to a watchpoint.

Example

The following command will test the program variable “count” and if
“count” is > than 25 a message will be written to the command
window and output file (if any).

if (count > 25) mess “warning count out of range”

Example 2

The following command will set a watch point at label in the main
function called “TEST_LABEL” test the value of the program
variable “zch1” and write a message out to a file open on 1/O channel
1 and then continue executing.

watch main():TEST_LABEL { if (zch1 < 4) fwrite /c:1
"zchl < 4\n";}
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input

Description

load a zap command file and start executing the commands.

Syntax

input <filename>

Function

The input command redirects command inputZ8P  Type the
“input” command, followed by a legal file namgiename> , to
redirect debugger command input so that it comes from the named
file. Aninput file may contain any valid ZAP commands.

This command is useful for entering debugger input from a command
file to provide an automated session.

The input command files continues to execute until the end of he
command file, or until another input command or the “escape” key is
pressed.

Example

To redirect input from the file demo.mac:

ZAP> input demo.mac

See Also

record, output
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Istep

Description

Execute one or more assembly instructions.

Syntax

istep [<condition>]

Function

Theistepcommand controls how many assembly instructions of your
programZAP executes. By defauistep executes one assembly
instruction. The <condition> associated to tis¢ep command can
take various forms: it can be<gount>, a specified file, a range of
lines in a specified file, a specified function, or a range of lines in a
specified function. It is then possible to instruct the debugger to step
through the program until a specified line is reached.

If you specify a number for the <conditiori2AP will execute the
specified number of assembler instructions instead. If you specify a
location for the <condition>, ZAP will execute one assembly
instruction at a time until it reaches the location. All open windows
will be refreshed after every single step.

While executing assembler instructions the disassembler window is
always open and the current machine instruction is highlighted with a
‘>’ character at its left.

Example

To single step 10 assembly instructions:

ZAP>istep 10
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To step assembly instructions until you reach fundemstr()

To step assembly instructions until you reach any line imféén.c

To step assembly instructions until you reach line 4aud()

Alias - si

Thesi command is an alias fistep.
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load

Description

Load file

Syntax

load [/<options>] <file>

Function

Theload command is used to load a file. The loading happens
exactly as if the file had been specified from the file menu of Afe

The PC is set to the address of the symbol __stext, which is typically
defined in the crts run time startup routine and used for the reset
vector. If this symbol is not found, ZAP will set the PC to the first
address of the first .text segment. Any previously loaded files are
completely lost.
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MesSsS

Description

Print a formatted message

Syntax

mess “format” <expression>

Function

The mess command displays a character string, including values
converted from expressions. This command acts as the C function
printf. The format string is followed by zero, one or several expres-
sions, separated by spaces or by commas.

The format may contain symbolic characters (escape sequences) and
several conversion sequences composed By aHaracter followed

by a single letter. Each converter will correlate to an expression from
the command line, evaluate it, and insert it in the output, converted as
required. Converters are the following:

%d The result is converted to signed decimal.

%u  The result is converted to unsigned decimal.

%X The result is converted to hexadecimal, prefixed(x}.“
%0 The result is converted to octal, and prefixed Gy “

%c | The result is displayed as a single character. There is no special
replacement for control characters. They are displayed as received.
There are no single quotes around the character.
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9%s | if the result is an array of char or a pointer to char, the string
pointed at is displayed until a terminating NUL character is reached.
There are no double quotes around the string, but control characters
are mapped into their symbolic C representation.

Example 1

To print the program variabtebi:

ZAP> mess “tab[%d] = %x\n” i,tabli]

the following is output to the command window:
tab[2] = 0x10

Example 2

To print a variables and it's address on two separate lines:

ZAP> mess “varl=%d \n &var1=%x\n" varl,&varl

the following is output to the command window:
varl=3
&varl=0x60

See Also
fwrite
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monit

Description

Monitor an expression

Syntax

monit /[options][<expression>]*

Function

Themonit command instructs the debugger to start monitoring the
value(s) specified byexpression>When you specify several
expressions, they must be separated by commas.

Monitoring consists of displaying the updated value of the specified
expression every time the debugger prompts for more input. The
expression is displayed only when in scope.

To stop monitoring, use tleel /m command, giving it the number of
the monitor.

By default, pointers and addresses are displayed in hexadecimal,
while signed or unsigned types are displayed in decimal.

You can force a specific display format by using one of the following
extensions:

Options
/d  force signed decimal output.
/u force unsigned decimal output.

Ix force hexadecimal output. The value is prefixed by “Ox”.
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/o force octal output. The value is prefixed by “0".

lc  force character output. The result is displayed as a character
between simple quotes. If it is a control character, it is replaced by its
symbolic C representation

Is  force string output. If the expression evaluates as a character
pointer or an array of characters, the pointed string is displayed
between double quotes. Control characters are replaced by their
symbolic C representation.

If you specify an already existing monitor, the new specification will
be used to update the display format.

Example

To monitor variablec, type:

ZAP>monit ac

this will cause the following result to be displayed in the monitor
window:

(1) ac =3 to be displayed.

To monitorac in hexadecimal:

ZAP>monit /x ac

this will cause the following result to be displayed in the monitor
window:

(1) ac = 0x3

To monitor variables andj , type:

ZAP> monit i
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followed by:

or more simply:

To remove the second variable in the monitor window type:

Alias - m

Them command is an alias for monit.
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move

Description

Move in stack frame

Syntax

i <direction>[<address> ]

Function

Themovecommand changes the scope of the C source you are
inspecting in increments of “stack framesVlove followed by a

direction option moves the window up or down one or more stack
frames in the direction you specify. Stack frames are the regions of
storage that the compiler allocates and deallocates from the region of
storage known as the “stack.” A stack frame holds the calling
environment of the expression that called the executing function, the
argument data objects passed on the function call, and all of the data
objects declared within the function that have dynamic lifetimes. You
direct movement of the scope by specifying:

Options
u to move up one stack frame,
d to move down one stack frame,
t  to move to the top stack frame,

b to move to the bottom stack frame.
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The function main is usually at the top of the stack. If you specify an
addressaddress> ZAP moves the window as many frames as
necessary to get to a stack frame that is in scope for that address.
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output

Description

Capture ZAP command window output.

Syntax

output <filename>

Function

The “output” command is used to capture all command responses
from ZAP. To close an output file simply type “output” on a line by
itself. By default, ZAP opens a new file each time the output
command is used with a <filename> and overwrites any previous file
of the same name. Only one output file can be open at any one time.
If a second output command is issued while another file is open the
first file is closed and the second file is opened and starts capturing
output.

This command is useful for saving debugger output in a file for
inspection or for comparing it with the results of a previous session.

The “output” redirection stops when the command ‘output’ is entered
without an argument. The “escape” key does not stop output
redirection.

Options

/a  Append to the output file.

Output is always echoed onto the screen, and only the results of
commands displayed in the command window and the output file.
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Example

To save the output of the debugger in fideout

ZAP> output res.out

See Also

input, record
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ostep

Description

Execute one or more source lines and step over function calls.

Syntax

ostep <condition>]

Function

Theostepcommand controls how many source lines of your program
ZAPexecutes. By defaulbstepexecutes one source line of code and
steps over a source line if it's a function call.

The <condition> associated to thesteg command can take various
forms: it can be &count>, a specified file, a range of lines in a
specified file, a specified function, or a range of lines in a specified
function. It is then possible to instruct the debugger to step through
the program until a specified line is reached.

If you specify a number for the <conditionZAP will execute the
specified number of source lines, but will not trace into functions. If
you specify a location for the <condition>, ZAP will execute one
source line at a time until it reaches the location. All open windows
will be refreshed after every single step.

While executing source lines the source window is always open and
the current source line is highlighted with a >’ character at its left.

Example

To single step 10 source lines in the current function without entering
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any called functions:

ZAP>ostep 10

To step one source line at a time in the current function without
entering any called functions until you reach line 4pwif) which is
assumed to be the current function.

ZAP>ostep put():45

Alias - so
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path

Description

Set the search path for ZAP to locate application source files for
display.

Description

The path command is used to set the search path for ZAP application
files.

path <PATH1|PATH2>

Thepath sets and displays the current search path that ZAP will use
to locate application source files. To display the current path simply
type path.

Example

To set the search path to “c:\source”, type:

ZAP>path “c:\source”

ZAP will now search only “c:\source” to find application source files.

To set the search path for ZAP to search “c:\source” and then search
“c:\work”, type:

ZAP>path “c:\source|c”\work”

ZAP will now search “c:\source” first and then if it doesn't find the
file it will search c:\work.
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print

Description

Print object

Syntax

print <object>

Function

Thep command prints an object which can be either a file or function
or a specified number of lines in a file or function.

Options

a Display address and disassembly with the source code.

Example

To print all of crtsi.s with addresses and disassembly

ZAP>print /a crtsi.s:

To print functionmain()

ZAP>print /a main():

To print lines 30 to 45 in filenain.cwith addresses and disassembly

ZAP>print /a main.c:30:45
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quit

Description

Quit the debugger

Syntax

quit

Function

To end a debugging session without stepping through to program
termination, simply enteguit.

quit terminates program execution and exits to the host environment
immediately.
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record

Description

Record all ZAP commands to a file for playback.

Syntax

record <filename>

Function

Therecord command saves all commands entered in the command
window or created via the mouse. The resultant record file can then
be used as input to the command window to replay a previous
debugging session. Type the “record” command, followed by a legal
file namex<filename> . The record command continues to record to
the same file until a record command is issued without a filename.
The “escape” has no effect on tleeord command.

NOTE
Not all mouse actions can translated to command line input
therefore some actions may not be recorded.

Example

To record ZAP commands to the file “test.rec™:

ZAP> record test.rec

When you want to stop recording and close the record file “test.rec”
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just type record by itself in the command window:

ZAP> record

After the record file is closed you can replay the recorded commands
it by using the record file as input to the command window:

ZAP> input test.rec

See Also

input, output
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regs

Description

Dump processor registers to the command window and/or output file.

Syntax

regs

Function

‘regs is used to capture the processor registers to a file or view them
on the screen. The register dump from the regs command is automat-
ically captured by an output file if one has been opened by the
“output” command. The register dump is always echoed to the
command window.
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rem
Description
Comment
Syntax
Function

rem allows you to write a comment, mainly in a command file or a
function. The content of the remaining text up to the end of line is
ignored by the debugger.

Example

In a command file:

Alias - *

Comments may be created with either the asterisks or the command
rem.
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remove

Description

Remove a file from the ZAP command window or input file.

Syntax

remove <filename>

Function

Theremovecommand deletes the specified file from your system.
Type the “remove” command, followed by a <filename> including
the full path. The local path fefiename> is the ZAP executable
directory.
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reset

Description
Reset the processor and set the PC to the reset vector address.

Syntax

reset

Function

Theresetcommand will perform a processor reset. ZAP will save all
breakpoints and monitors during a reset. In simulation, all CPU
registers are set to the appropriate reset values and the reset vector
address is loaded into the $PC. In hardware versions of ZAP, the
emulator or processor itself is reset so all reset conditions are
generated through the hardware.

Example

To reset the processor:

ZAP>zbm

See Also

Zero
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rewind

Description

Rewinds the specified channel. This command resets the file pointer
in the file associated with the channel causing the next fread (after a
rewind on the same channel) to start reading from the beginning of
the file.

Syntax

rewind /c:<number>

Function

Therewind command is used to force the fread function to read from
the beginning of an open file. By default, fread will increment it’s

file pointer each time it is executed with the same open file. The
rewind command is equivalent to an fclose and an fopen of the same
file and channel.

Example

To rewind channel 1, which corresponds to the file “foo.txt”:

ZAP> rewind /c:1

This sets the file pointer back to the beginning of the file so that the
next fread of this channel will get data from the start of the file.

See Also

fopen, fclose, fread, fwrite
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session

Description

Load or Save a session to a file.

Syntax

session /{<options>] <filename>

Function

Thesessiorcommand loads or saves a ZAP session from/to
<filename>. A session contains the search path for source file, the
last file loadeg the type of windows (cascade, tile or free) and the
following windows if open:

Command window - saves/loads size and location of the window
Register window - saves/loads size and location of the window
Source window - saves/loads size and location of the window
Disassembly Window - saves/loads size and location of the window
Stack Window - saves/loads size and location of the window

Monitor Window - saves/loads the size, location and contents of the
window.

Data Window - saves/loads the size, location and starting address of
the window.

Options
l Load a ZAP session.

Is Save a ZAP session (default).
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Example

To save a ZAP session:

ZAP>session /s projectl.ssn

See Also

record
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stack

Description

List known stack frames

Syntax

stack

Function

Thestackcommand displays a complete list of known stack frames
from the current stack frame to the top stack frame (usually your
program’s “main” routine). Function arguments are displayed inside
the function braces.

Example

To display the current stack frame:

ZAP> stack

The following is output to the command window:

main( )
foo(12,34)
bar(50,30)
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step

Description

Execute one or more source lines

Syntax

step <condition>]

Function

The stepcommand controls how many source lines of your program
ZAPexecutes. By defaulstepexecutes one source line of code.

The <condition> associated to thet€p command can take various
forms: it can be acount>, a specified file, a range of lines in a
specified file, a specified function, or a range of lines in a specified
function. It is then possible to instruct the debugger to step through
the program until a specified line is reached.

If you specify a number for the <conditionZAP will execute the
specified number of source lines. If you specify a location for the
<condition>, ZAP will execute one source line at a time until it
reaches the location. All open windows will be refreshed after every
single step.

While executing source lines the source window is always open and
the current source line is highlighted with a ‘>’ character at its left.

Example

To single step 10 source lines:

ZAP>step 10
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To step one source line at a time until you reach fundtiostr()

To step one source line at a time until you reach any line iméia.c

To step one source line at a time until you reach line 4mutgj

Alias - s

Thescommand is an alias fetep
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update

Description
Update a data object

Syntax

update [/<options>] <variable>[=]<value>
update [/<options>] <variable>[=]<const_expression>

Function

Theupdate command updates a data objestariable> by storing a

new value<value> in it. <variable> is an expression providing an
updatable location, such as a C language LVALUE,<arue> is

an expression whose result will be copied into the described location.
This command displays the old and new value associated with the
location descriptor. You can enter a full expression that will be
evaluated. The result will be transferred into the updatable location.

The ‘=’ sign is only mandatory when thevalue> starts with an
unary operator; for example whemalue> is +1 or -2.

If <argument>is an array of char, or a pointer to char, it is possible to
set the string pointed at by the following syntax:

update <argument> <string>

where<string> is either a string constant written between two double
quotes, i.e. “hello”. The character string follows the same rulesasa C
character string, except for the terminating NUL. You can use
symbolic representation for control characters (escape sequences).
The string is not terminated by a NUL character. If you want to do so,
you have to specify it explicitly by a \0.
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Example

To update an integer:

o

r

unsigned inti 2 => 3

To update an integer with a negative value:

o

r

This command copies the string “abc” with a terminating Nul
character to terminate the string.

Alias - u
Theu command is an alias for update.
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vars

Description

Open a global variable browser window.

Syntax

vars [<options>]

Function

Thevars command is used to open a dynamic variable browser
window. This command is equivalent to selecting
“Browse->Variables->in global list” from the pull down menu. Each
command will open a new window.

Options

/a | Display address of variables in the window. The /v and the /a
option together are equivalent to the “browse ->variables->format-
>full” pull down menu item.

Iv | Display the variables value in the window. The /v option is
equivalent to “browse -variables->format->standard” pull down
menu items.

See Also

monit
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watch

Description

Set, modify or display a watch point event. A watch point is the same
as a break point except that when the break condition is met and the
action has completed ZAP will silently continue execution. Watch
points are used for events where only the execution of the action is
desired.

Syntax

watch [/<options>] [<address_range>][{<action}]

Function

Thewatch command sets or displays the “watch point” at
<address_range>

A watch point is an event that causes execution of your program to be
interrupted so an <action> can be performed. You can set a break-
point on any C source line. Program execution will be temporarily
interrupted when control passes to that line.

A watch can also be set on a range of lines rather than on a single line.
Ranges of lines are specified using theharacter. For example if

you want to set a watch point on lines 20 to 35 of function main() you
would type:watch main():20:35 . Typing for examplevatch

main():34  sets a watch point on lir8 of main() only.

Options
/la  Reactivate a suspended watch point

[c:<count> can be used to specify an optional count, which
specifies the number of times the watch point must be reached before
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the action is performed. It is then possible for example to set a watch
point when a particular C line has been executed a specific number of
times.

/s | Suspend an active watch point

<action> can be anZAP valid command or set of commands. The
default <action> is to enter debug mode and prompt you for
command input.

The display of a watch point includes various information: first the
watch point number between parenthesis, this number will be used to
delete the watch point, then thargument>associated with the

watch point, second between {} the action associated with the watch
point, third either (user) to indicate that the watch point has been set
by the user or (internal) to indicate that the watch point has been set
by ZAP itself for performing its work; and then the count associated
with the watch point and the number of times left before the watch
point will be taken.

To suspend a watch point, use theption. The watch point is still
set, but is not active.

To reactivate a suspended watch point, uséatlogtion.

To set a watch point on the third execution of line 13 in the file main.c
and perform an <action> then continue execution.:

ZAP>watch /c:3 main():13 {<action>}

The debugger will display:
(xx) main.c:13 {<action>} (user) (count=3, left=3) (on)

To attach the <action> below action to the above watch point which
will change the value of foo to 5 on the third time line 13 of main.c is
executed and then ZAp will continue execution.

Example action:
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<action > = “update temp 5"
The debugger will display:

(xx) main.c:13 {update foo 5} (user) (count=3, left=3) (on)

To list all the events currently set:
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wregs

Description

Toggle the register window

Syntax

wregs

Function

‘wregs is used to open and close the register window. The register
window when open, will be updated every time the debugger prompts
for a new command, or when you are stepping through your program.
The register display includes all registers of the target processor. You
can double click on any register name or value in the register window
to change the value.

See Also

regs
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write

Description

Write components to a file

Syntax

write /{<options>] <filename>

Function

Thewrite command writes a filefilename>containing user defined
components oZ AR The result is a text file that you can display or
edit as you would any text file on your host system. This file may be
reloaded using the input redirection command AP

Options allow you to save selectively breakpoints, monitors, user
functions and function keys:

/e = Save all user events.

/m  Save monitors.

If no option is specified, all components are saved.

The “write” command opens and overwrites the named file each time
it is used. So do not create a file that has the same name as another
file in your current working directory.

Example
To save the breakpoints only to the Blavl

ZAP>write /e savl
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See Also

input, output
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wstack

Description

Toggle stack frame window

Syntax

wstack

Function

wstackis used to open and close the stack window. When the stack
window is open it is updated when execution stops.
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Zero

Description
Zero out all events, monitors or issue a processor reset.

Syntax

zero /[<options>]

Function

zero will reset the debugger and restart the execution of the appli-
cation from the same entry point as in the original loading. The
program counter is moved to the entry point, leaving all other
registers, including the stack pointer, unchanged.

Options

le Zero (delete) all events including breakpoints and watch
points.

/m Zero (delete) all monitored variables from the monitor
Window.

Ir  Reset the processor

Example

To remove all breakpoints, all monitors and reset the processor.:

ZAP>zero /e /Im /Ir

See Also

reset, del
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